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This “Getting started” document provides detailed instructions on using IBM i on a POWER node.  It 
covers prerequisites, supported configurations, preparation for install, hardware and software install, 
firmware updates and post-install tasks such as backups.  The document also contains links to many 
additional information sources. 

1 Overview and Concepts 

1.1 IBM PureFlex System 

When ordering the IBM PureFlex System with a POWER node as the primary operating system, 

you will need to choose which version you want: Express, Standard or Enterprise. Each comes 

with predefined IBM Storwise V7000 or the Flex System V7000 Storage Node® LUNs; zoned 

Fibre Channel switch or switches; configured Ethernet switch or switches and a reloaded Flex 

Systems Manager.   For more detail on the content and configurations used in these offerings, 

please see the infoCenter documentation here: 

http://publib.boulder.ibm.com/infocenter/flexsys/information/index.jsp 

 

1.2 Logical Partitioning (LPAR) or Virtual Servers   
 
Similar to other Power® systems, POWER nodes can be partitioned into separate environments called 
either logical partitions (LPARs) or virtual servers depnding upon the management interface being used.  
POWER nodes support the virtual I/O server (VIOS) as a hosting partition and client partitions running 
IBM i, AIX or Linux. AIX and Linux can also run standalone.  This document will only be addressing VIOS 
hosting IBM i.  Any physical adapters installed on the node are owned by VIOS. VIOS then virtualizes 
disk and optical storage and network resources to the client partitions.  An IBM i LPAR on the node does 
not have direct access to any physical hardware on the node or outside the BladeCenter chassis.  
Physical adapters can not be assigned directly to the IBM i partition.   
 
You will use the Flex Systems Manager (FSM) for the management of your POWER node. One key 
function that FSM brings to POWER nodes is the ability to manage redundant VIOS virtual servers. The 
POWER node does not support a Hardware Management Console (HMC).  An LPAR on FSM is referred 
to as a virtual server.  The term LPAR will be used to refer to either term throughout this document. 
 
When FSM is not used to manage the node,  VIOS is always the first LPAR installed on a partitioned 
POWER node. With FSM that is no longer a requirement.  As soon as VIOS is installed, other partitions 
can be created using the management interface.  FSM is a hardware appliance: it has its own x86 based 
node.   

1.3 Overview of I/O concepts for IBM i on node 
 
The Power node needs to include a set of adapters for I/O called mezzanine adapters. There are 
Ethernet and Fibre Channel (FC) mezzanine adapters available. Typically for IBM i, the VIOS hosting 
partition owns these adapters and virtualizes their use to the IBM i client partition. IBM i partitions on a 
Power node can only use external Fibre Channel storage, there are no SAS adapters available. 
 
The storage is physically connected to VIOS using a supported  FC mezzanine adapter for the node.   
VIOS supports two types of storage virtualization: virtual SCSI and virtual fibre channel.  Each of these 

will be discussed in more detail in the “Storage management concepts” section of this document.    

 
For vSCSI, the FC LUNs are mapped to VIOS and from there they are virtualized to IBM i. On IBM i each 
LUN appears as a disk drive.  IBM i is installed using from a virtual media library in VIOS. 

http://publib.boulder.ibm.com/infocenter/flexsys/information/index.jsp
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IBM i partitions have Ethernet connectivity also using VIOS virtualization.  The ports on the Ethernet 
mezzanine adapter are owned by the VIOS partition which bridges them to a virtual Ethernet adapter that 
is associated with the IBM i client partition.   
 
The FSM supplied console is the only console option.  An SDMC or HMC supplied console, Operations 
Console (LAN console), thin clients or twinaxial connections are not supported.  IBM i partitions use the 
network virtualization framework explained above for their production TCP/IP traffic.  If more than one 
connection is required, it is recommended that two separate Virtual Ethernet adapters be created for the 
IBM i partition.  The two adapters can then reside on the same Virtual LAN (VLAN) or on separate VLANs.  
They can connect to the outside network using the same Ethernet adapter port or different ports.   
 

Refer to the Backup and restore section of this paper for an explanation on the save and restore options 

for IBM i on node, as well as the procedures for saving and recovering VIOS. 
 
Figure 1 shows an example Power node environment with two LPARs as clients of VIOS. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 1: A conceptual view of VIOS owning a storage adapter and virtualizing it to two client partitions. 
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1.4 Review terminology 
 

Terminology Description 

Chassis 

 

The enclosure containing the node servers, I/O 
modules, CMM, power and fan modules. 

Chassis management module (CMM) 

 

A control module residing in a special I/O bay in the 
chassis. The CMM provides browser and command-
line interfaces (CLI) into the chassis and interfaces to 
the other chassis components. 

I/O bay 

 

A slot for an I/O module (switch) inside the chassis. A 
chassis has two sets of high-speed switch bays..  

Scaleable switch node 

 

A switch residing in the chassis that provides 
connectivity between the node servers and external 
I/O. 

Compute Node 

 

A standalone server residing in a node slot in the 
chassis. The can be POWER or x86 based processors. 

Flexible Service Processor (FSP) 

 

The FSP on the POWER node is similar to the FSP on 
other POWER7 processor-based systems. It contains 
firmware to manage the hardware on the node; the 
Power Hypervisor; and Partition Firmware (PFW). 

Imbedded Management Module (IMM) The service processor on an x86 node. It is used to 
manage the x86 node server for remote access and for 
firmware updates.  It communicates to the CMM as part 
of chassis management. 

System firmware 

 

As with other POWER7 processor-based systems, this 
is the firmware on the FSP. 

I/O expansion card  

Or mezzanine adapter 

Sometimes called a daughter card, this card is an I/O 
adapter that fits into a PCI Express (PCIe) connector 
on the node and allows connectivity to external I/O 
devices through the chassis midplane and I/O modules. 

Adapter firmware 

 

The firmware on the I/O expansion cards on the node. 

Virtual I/O Server (VIOS) 

 

A software appliance that is located in a logical 
partition. This software facilitates the sharing of 
physical I/O resources between client logical partitions 
within the system. 

Virtual Ethernet adapter:   

 

A virtual network adapter created in the POWER 
Hypervisor that is part of an LPAR’s hardware 
resources.  On POWER node, IBM i cannot be 
assigned physical network adapters. 

Virtual SCSI adapter:   

 

A virtual storage adapter created in the POWER 
Hypervisor that is part of an LPAR’s hardware 
resources. On a POWER node, a VSCSI client adapter 
is created in IBM i and a VSCSI server adapter is 
created in VIOS for storage virtualization. 



 

 Getting Started with IBM i on an IBM PureFlex System Compute node 8 

Virtual Ethernet bridge:   

 

A VIOS function that allows Layer-2 bridging of a VLAN 
to an outside physical LAN. It is called a Shared 
Ethernet Adapter (SEA).  It is required on a POWER 
node to provide networking to IBM i. 

Logical Unit Number (LUN):   A logical volume created on a storage area network 
(SAN) system that appears as a single disk device to a 
server. 

Disk drive module (DDM):   

 

A physical disk unit in a SAN system. 

Subsystem Device Driver – Path 
Control Module (SDDPCM)  

 

A multipath I/O (MPIO) driver installed on top of VIOS 
for certain storage subsystems – in particular, V7000 
and SAN Volume Controller (SVC). 

Redundant Disk Array Controller 
(RDAC) 

 

A MPIO driver for IBM System Storage DS4000® or 
DS5000, which is included with VIOS. 

Serial-attached SCSI (SAS) 

 

A storage access protocol, which is the next generation 
of the parallel SCSI protocol. 

Virtual Fibre Channel adapter 

 

A virtual storage adapter created in VIOS that is part of 
an LPAR’s hardware resources. On a POWER node, a 
VFC client adapter is created in IBM i and a VFC 
server adapter is created in VIOS for storage 
virtualization. This creates virtual World Wide Port 
Names (WWPNs) for use in the client partition. 

Flex Systems Manager (FSM) x86 node based hardware appliance for managing the 
components in an PureFlex System chassis. 

Host:  

 

Another term for server or physical server, used by 
FSM, FSM and Systems Director interfaces, 

Virtual server:  

 

Another term for logical partition, used by FSM, FSM 
and Systems Director interfaces. 

 
 

1.5 Plan for necessary IP addresses 
 
You should plan to assign IP addresses to the following components for a minimum IBM i on node 
configuration.  All the addresses below are typically configured on the same subnet. 
 

 CMM (this IP address is defaulted to 192.168.70.100) 
o The CMM IP address is a physical LAN IP address.  It is used to manage the chassis and 

node servers 

 IMM (this IP address is defaulted to 192.168.70.1xx, where xx is the node slot number) 
o This IP address is used to manage the x86 node server. 

 I/O module (switch, these IP addresses are defaulted to 192.168.70.120-123)  
o This IP address is used for management of the switch. There can be from 1 to 4 of these 

modules in a chassis. 

 VIOS 
o An IP address on the external LAN that is used to connect to the VIOS command line 

interface. 
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 FSM 
o An IP address on the external LAN that is used to connect to the FSM to manage the 

chassis and its components  

 FSP  
o An IP address is needed on the external LAN to connect to the service processor of the 

Power node.  This is used by FSM to manage the node. 

 IBM i production interface 
o An IP address on the external LAN that is used for IBM i production network traffic.  This 

address is configured after IBM i is installed.   
 
From a network perspective, one significant difference between the POWER node and a standalone 
server is that each Ethernet port on the POWER node connects to the outside LAN through a separate 
Ethernet module in the chassis.  The first port is hard-wired to I/O module bay 1 and the second one to 
I/O module bay 2.  Figure 2  shows the Ethernet virtualization concept. The switch shown would be in I/O 
Bay 1. 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 2: Sample virtual Ethernet network configuration for a basic IBM i  installation. 
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2 Software details 
  

2.1 Supported environments 
The minimum level of the Virtual IO Server (VIOS) that is supported is 2.2.1.4 which was made available 
in May 2012. 
IBM i releases:  

 i6.1 is supported, but can not be ordered preinstalled from IBM manufacturing. 

You must manually install it yourself. 

 i7.1 is supported and can be ordered preinstalled from IBM manufacturing. When 

ordered in this way, the VIOS supplied media repository will contain the i7.1 

microcode, operating system and licensed program products. It will not contain 

PTFs (fixes), but these can be loaded manually). 

3 Hardware details 
  

3.1 Supported environments 
 
For a list of supported hardware, firmware and software for the IBM i on POWER node environment, see 
the Flex Interoperability Guide:  http://www.ibm.com/common/ssi/cgi-

bin/ssialias?subtype=WH&infotype=SA&appname=STGE_WZ_WZ_USEN&htmlfid=WZL12345USEN&attachment=W

ZL12345USEN.PDF 

3.2 POWER nodes 
Use the links below to see current information on the Power nodes. 

 IBM PureFlex System Products & Technology,  
http://www.redbooks.ibm.com/abstracts/sg247984.html?Open 

    IBM Flex System p260 and p460 Planning and Implementation Guide,  
      http://www.redbooks.ibm.com/abstracts/sg247989.html?Open 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ibm.com/common/ssi/cgi-bin/ssialias?subtype=WH&infotype=SA&appname=STGE_WZ_WZ_USEN&htmlfid=WZL12345USEN&attachment=WZL12345USEN.PDF
http://www.ibm.com/common/ssi/cgi-bin/ssialias?subtype=WH&infotype=SA&appname=STGE_WZ_WZ_USEN&htmlfid=WZL12345USEN&attachment=WZL12345USEN.PDF
http://www.ibm.com/common/ssi/cgi-bin/ssialias?subtype=WH&infotype=SA&appname=STGE_WZ_WZ_USEN&htmlfid=WZL12345USEN&attachment=WZL12345USEN.PDF
http://www.redbooks.ibm.com/abstracts/sg247984.html?Open
http://www.redbooks.ibm.com/abstracts/sg247989.html?Open
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4 Chassis installation, configuration and firmware updates 

4.1 Install the PureFlex System chassis and  node hardware  
 
The first step is to install the PureFlex System chassis and node hardware. This might include installing 
any management modules, power modules, and I/O modules in the chassis. The chassis might have 
these components already installed if an additional node server is being added to an already functioning 
chassis. Before installing the nodes in the chassis, any node options must be installed. This might include 
additional processors, additional memory and I/O mezzanine cards. For POWER node servers, any 
required mezzanine adapter are installed at this time, depending on the chassis and storage used.  Refer 
to the node and expansion card documentation that came with the option for details on installing each 
one. After installing the node options, you can install the node in the chassis. Refer to chassis and node 
documentation for details on how to install the components.  After installing all the node options, installing 
the node into the chassis, and installing the chassis I/O modules, the chassis can be connected to the 
power outlets.  
 
Note: If you need to add a new node to an existing chassis, consider updating the chassis component’s 
firmware at this time. 

4.2 Configure the Chassis Management Module (CMM)  

4.2.1 Initial CMM configuration (New chassis install) 
On Express and Standard Foundation single chassis configurations, the CMMs have Ethernet cables 
plugged into the 7

th
 and 8

th
 Ethernet ports of the EN4093 switch in IO bay 1.  For multi-chassis and 

Enterprise Foundation configurations, the CMMs have Ethernet cables plugged into ports on one of the 
8052 Ethernet top of rack (TOR) switches. 
Configure the Ethernet adapter on you PC to the 192.168.93.xxx subnet and set the subnet mask to 
255.255.255.0.  Then cable you laptop to port 5 of the EN4093 or any open port on the 8052 TOR switch.  
These ports are on the management subnet configured on the switch.   
You need to perform the following steps on a browser on the computer that is connected to the CMM:  
 
You can ping the 192.168.93.100 address to confirm communications to the CMM. 
Open a web browser on the computer connected to the CMM. In the address or URL field, type the IP 

address (192.168.93.100 is the default) of the CMM to which you want to connect. If you can not 
communicate to the CMM and you have tried another cable, and rebooted the PC, there is a pin hole 
reset option at the top of the CMM.  Take a paper clip and insert it into the pin hole, push it in and 
hold for 10 seconds to reset the CMM to its factory defaults. The lights on the CMM should flicker and 
the fans in the chassis will reset after a few seconds. Resetting the CMM this way returns all 
configuration values to the factory defaults, including the enabled external ports of the IO modules. 

In the Enter Password window that is displayed, type the user name and password. The management 
module has a default user name of USERID and password of Passw0rd (PASSW0RD for factory 
defaults) (where 0 is a zero, not the letter O).  Both of the values are case sensitive.  Select a timeout 
value on the bottom of the  page and click continue. 

A startup wizard runs that can be used for the following steps.  

4.2.1.1 New and predefined CMM user IDs 
The Power node will  
To create additional user profiles on the CMM:  

 From the Mgmt Module Management pulldown, select User Accounts  

 Click on Create User…and fill in the ID and password information.  Also choose a 
Permission Group for the new user and click Finish. 
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 While on the User Accounts screen, click on the HMC user ID.  This ID will be used to grant 
access to any Power node’s service processor in the chassis.  Set the password to 
Passw0rd (it is case sensitive and that’s a 0 not an o).  Set the Permission Group  to 
Default Supervisor Group then click OK. 

 

4.2.1.2 CMM IP configuration 
 

To configure the CMM so that it is accessible on the local network:  

 Select the Mgmt Module Management pulldown, then click on Network 

 Enter a host name for the CMM.  If the CMM is going to use DHCP, choose the option Try  IP 
DHCP Server. If it fails, use static config in the IP address assignment method drop-
down menu   

 If the CMM is going to use a static IP address, choose the option Disable – Use static IP 
address, then enter the static address, subnet mask and default gateway IP addresses   

 Scroll to the top of the page and click Apply. 

 A reset of the CMM is required to make the changes take affect. 

4.2.1.3 Assigning an IP address to I/O modules 
With CMM configured the next step is to configure IP addressing for the other components within the 
chassis.  You will need to manually configure the IP addresses for the chassis I/O modules.  
Instructions in the README files assume that the I/O module you are updating is accessible through 
the CMM browser UI.  To assign an IP address to an I/O module: 

 

 Log into the CMM browser UI with an administrator ID 

 From the Chassis management pulldown, select Component IP configuration 

 Select an I/O module by clicking on its Description.  

 Select the IPV4 tab.   

 Change the Configuration Method to Use Static IP Address then enter the static address, 
subnet mask and default gateway IP addresses and click Apply, then click the Cancel button 
to exit. 

If you intend to access the I/O modules through the CMM interface, ensure that they are on the 

4.2.1.4 Assigning an IP address to the Power node’s FSP 
The next step is to configure IP addressing for the Power node(s) within the chassis.  A default value 
will have been set at the factory, but the client will likely want a different IP assigned.  To assign an IP 
address to the Power node(s): 

 

 Log into the CMM browser UI with an administrator ID 

 From the Chassis management pulldown, select Component IP configuration 

 Select a Power node by clicking on its Description.  

 Select the IPV4 tab.   

 Change the Configuration Method to Use Static IP Address then enter the static address, 
subnet mask and default gateway IP addresses and click Apply, then click the Cancel button 
to exit. 

 
 
 
 

4.3 FSM Discovery and access of Power nodes  
 



 

 Getting Started with IBM i on an IBM PureFlex System Compute node 13 

FSM supports the discovery of POWER nodes, but first you need to manage the chassis that the nodes 
are in.  This is accomplished by the FSM communicating with the CMM.  When the FSM starts it 
automatically discovers the chassis that it is installed in.  Next you need to manage that chassis.  
From the FSM Home page, click the Manage Chassis… link. A partially defined chassis should be 
shown.  Select that entry and click Manage.  This can take a while, as the components of the chassis are 
discovered and identified.  Please be patient. 
 
Discovery is the process which is used to establish connections with resources that can managed. A 
Power node is one type of resource. Discovery of nodes and virtual servers is a two step process – 
running inventory and requesting access.  Each option is available by right clicking on the object and 
selecting either Inventory->Collect Inventory or Security->Request Access. 
 
A discovered Power node is displayed under Hosts on the Manage Power Resources tab of the FSM.  
Requesting access is an authentication step to ensure you have correct authorization to access that host 
(a user ID and valid password).   
 
 

4.4 FSM chassis component firmware update process 
The intention with PureFlex System is that the Flex System Manager (FSM)  will supply a single interface 
for determining, downloading and installing all chassis component firmware.  Assuming that the FSM has 
connections to the internet, this is done from the home page.  The Plug-ins tab shows an Update 
Manager that can be used to access the chassis components and IBM fix central to determine which 
fixes would be applied.  If internet access is not available, you can manually download updates from IBM 
Fix Central and import them into the FSM for applying them at a later time. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5 Storage management concepts   
If you are need a better understanding of storage area networking concepts, refer to the Storage area 
networks 101 section of the IBM i Virtualization and Open Storage Read-me First at: 
http://www.ibm.com/systems/resources/systems_i_Virtualization_Open_Storage.pdf   
 

http://www.ibm.com/systems/resources/systems_i_Virtualization_Open_Storage.pdf
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IBM i on all POWER nodes supports Fibre Channel(FC) only.  Network Attached Storage (NAS) through 
iSCSI to VIOS is not supported for IBM i as direct installation disks. NAS storage, and any other storage 
that is supported by the IBM Storwise V7000 is supported for IBM i through VIOS. 
Refer to the System Storage Interoperation Center (SSIC) for the supported combinations of adapters, 
switches and storage area networks (SANs): 

http://www.ibm.com/systems/support/storage/ssic/interoperability.wss 

5.1 Storage concepts for POWER node  
In the POWER node environment, IBM i partitions do not have direct access to any physical I/O hardware 
on the node, in the chassis or outside the chassis.  In PureFlex System, disk storage is provided by 
attaching LUNs on a Fibre Channel storage area network (SAN) to VIOS, then directly virtualizing them to 
IBM i using the FSM interface.  DVD access for IBM i installation is provided by either using an external 
USB DVD or through the VIOS supplied virtual media library.  N-port ID Virtualization (NPIV) attached 

storage, including tape media libraries, are discussed later in sections N-Port ID Virtualization (NPIV) 

and Save and restore with a Fibre Channel-attached tape library. Note, at the time of this writing, 

NPIV is not available for IBM Storewise V7000 LUNs. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.1.1 Storage concepts for POWER nodes 
 
 
 
 
 
 

IBM i   

http://www.ibm.com/systems/support/storage/ssic/interoperability.wss
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Figure 3 Overview of storage, optical and tape virtualization for IBM i on Power nodes. 

 
An 8 Gb fibre channel (FC) mezzanine adapter is used to connect to FC storage. On a full-wide Power 
node, two FC  adapters can be used to provide separate adapters for VIOS redundancy. The ports on the 
adapter are hardwired to switches in IO Bays 3 & 4. 
Note: Ensure that you look at the combinations of adapters and switch modules for all of the nodes in 
your chassis. This is especially important when adding a node to an existing chassis. 

5.2 Configurations for Storage 

When ordering the IBM PureFlex System with a POWER node are the primary operating system, 

you will need to choose which version you want: Express, Standard or Enterprise. Each comes 

with a predefined IBM Storwise V7000 LUNs and a zoned Fibre Channel switch or switches.   

For more detail on the content and configurations used in these offerings, please see the 

infoCenter documentation here: 

http://publib.boulder.ibm.com/infocenter/flexsys/information/index.jsp 

 

 

5.3 Fibre Channel Configuration 

5.3.1 Best practices for PureFlex System and Fibre Channel storage  
 
When configuring LUNs for IBM i (virtualized by VIOS), follow the best practices outlined in chapter 18 of 
the latest Performance Capabilities Reference manual, available here: 
http://www.ibm.com/systems/i/solutions/perfmgmt/resource.html.  Note that some of its recommendations 
apply only to IBM i using virtual storage outside of the chassis environment. Although this section was 
written for a POWER node environment, it still pertains to the POWER node environment. 
 
In addition to the guidelines in the Performance Capabilities Reference manual, follow these additional 
recommendations: 

VSCSI 

  client 

  Disk Driver   Disk  Driver 

VSCSI 

 client 

  Disk Driver 

 
 fibre channel 

        HBAs 

 
 fibre channel 

        HBAs 

 multipathing  

http://publib.boulder.ibm.com/infocenter/flexsys/information/index.jsp
http://www-03.ibm.com/systems/i/solutions/perfmgmt/resource.html
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 Use Fibre Channel disk drives (and not SATA or FATA) to create the RAID ranks/arrays for 
production IBM i workloads 

 Use 15K RPM drives for medium and heavy I/O IBM i workloads, and 10K RPM drives for low I/O 
workloads 

 When creating a host connection to the WWPN of the Fibre Channel card on the node, specify at 
most two specific host ports.  Do not create the connection so that the Fibre Channel adapter can 
connect to all host ports on the storage subsystem, which is the default for some subsystems. 

 Properly zone the switches between the adapter ports and the SAN host ports.   

 When configuring vSCSI LUNs for IBM i within VIOS: as soon as the LUNs that will be virtualized 
to IBM i have reported in VIOS, change their queue depth to improve performance.  Start a Telnet 
session to VIOS and login as padmin.  Use the following command for each LUN = hdisk:   

 
o lsdev - attr -dev hdisk#, where # is the hdisk number you want to display. 
o chdev -perm -attr queue_depth=8 -dev hdisk1# 

 Note: The order of the parameters can be changed, as shown, to facilitate 
repeating the command and only having to alter the hdisk number. 

 Note: Some of the low end SANs might not handle the larger number of 
concurrent commands as well, which can adversely affect performance.   

 For redundant VIOS servers, each server needs to be able to access the same 
hdisks, so another attribute needs to be set for this: reserve_policy=no_reserve 
on each hdisk. Add a space between the attribute lists on the command.  

o lsdev -attr -dev hdisk#, to validate the change. 
 

 

 Another parameter that can improve performance is the number of I/O commands to send to the 
Fibre Channel adapter.  The recommended value is 512.  Be sure to change the value for all 
ports of all of the FC adapters: 

 
o lsdev -attr -dev fcs#, where # is the  FC adapter number you want to display. 
o chdev -attr num_cmd_elems=512 –perm –dev fcs# 
o lsdev -attr -dev fcs#, where # is the  FC adapter number you want to display to validate 

the change. 
 

 To improve reliability, enable dynamic tracking and fast fail over for the LUNs virtualized to IBM i.  
Fast_fail should be done only when multiple paths to the disks exist. Do so for all ports of the all 
of the adapters: 

 
o lsdev -attr -dev fscsi#, where # is the  FC adapter number you want to display. 
o chdev -attr dyntrk=yes fc_err_recov=fast_fail –perm –dev fscsi# 
o lsdev -attr -dev fscsi#, where # is the  FC adapter number you want to validate. 

 
Using the –perm option in these commands means that the value will be updated only in the VIOS device 
configuration database (ODM).  To make the change effective, reboot VIOS when there is downtime 
available for all client partitions. 

5.3.2 N-Port ID Virtualization (NPIV)  
VIOS uses N_Port ID Virtualization (NPIV) to allow IBM i direct access to a SAN through an NPIV-
capable adapter owned by VIOS.  NPIV is a FC technology that enables a single port on a FC adapter to 
be presented to the SAN as an N-number of independent ports with different WWPNs.  NPIV-capable 
adapters on IBM Power® nodes allow up to 256 virtual FC ports to be assigned to a single physical FC 
port.  On Power nodes, VIOS always owns and manages the FC adapter.   
 
To leverage NPIV, an IBM i LPAR must have a virtual FC client adapter created, which connects to a 
virtual FC   server adapter in VIOS.  However, the virtual FC client adapter does not allow IBM i to access 
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LUNs already assigned to VIOS in the SAN.  Instead, the virtual FC server adapter in VIOS is mapped to 
a FC port on the physical NPIV-capable adapter.  This allows the client virtual FC adapter in IBM i direct 
access to the physical port on the FC adapter, with VIOS having a “pass-through” role, unlike with VSCSI.  
The logical drives or LUNs in the SAN for IBM i use are not mapped to the WWPNs of the physical ports 
on the NPIV adapter and it does not become available in VIOS first.  Instead, when the virtual FC client 
adapter in the IBM i LPAR is created, two virtual WWPNs are generated by the PowerVM Hypervisor.  
The SAN LUNs are zoned directly to the first of the two WWPNs on the virtual FC client adapter in IBM i.  
The second WWPN is used to facilitate Live Partition Mobility.  The PowerVM Hypervisor on a Power 
node has the default capability to create 32,000 virtual WWPNs.  When virtual FC client adapters are 
deleted, WWPNs are not reused.  If all of the default 32,000 WWPNs are used, the client must obtain an 
enablement code from IBM, which allows the creation of a new set of 32,000 WWPNs.   
 
Note, at the time of this writing, NPIV is not available for IBM Storwise V7000 LUNs.  This is due to the 
IBM i requirement for 520 byte sectors on the storage attached via NPIV.   
 
Please refer to this information APAR for NPIV and IBM i requirements: 

http://www.ibm.com/support/docview.wss?uid=nas13b3ed3c69d4b7f25862576b700710198 

 

5.3.2.1 Support statements and requirements for FC tape libraries 
 

Please refer to this information APAR for NPIV tape requirements:  http://www-

912.ibm.com/n_dir/nas4apar.NSF/c79815e083182fec862564c00079d117/02327e067599839e86

257659003c6d66?OpenDocument 
 
Note that while the supported FC adapter and switch modules operate at 8Gb/s, the rest of the SAN does 
not have to operate at that speed.  Additional FC switches outside of the chassis can operate at 4Gb/s or 
2Gb/s.  While this difference in throughput will have an effect on performance, it will not prevent NPIV 
from working.   

5.4 Create LUNs for the IBM i partition(s) in PureFlex System  
To create LUNs for IBM i (virtualized by VIOS) on the Storwise V7000 storage subsystem, follow the 
instructions in Chapter 5 of the Implementing the IBM Storwize V7000 in IBM Redbooks available at: 
http://www.redbooks.ibm.com/abstracts/sg247938.html?Open 

5.5 Multi-path I/O (MPIO) 
MPIO refers to the capability of an operating system to use two separate I/O paths to access storage.  
For IBM i on an node, that capability resides with VIOS, because IBM i is not directly accessing the SAN.  
Additionally, IBM i does not currently support the ability to have two paths to the virtual disk units (LUNs) 
in VIOS from a virtual client/server perspective.   
 
POWER nodes can achieve a multipath redundancy with FC storage by using both ports on the 
mezzanine FC or FCoCEE adapter and a pair of FC switch modules.  The I/O redundancy can be 
extended by connecting to separate external FC switches or directly to separate ports on the storage 
subsystem.   
The full wide POWER node can support redundant adapter installation where redundant VIOS servers  
can each own their own mezzanine adapter. 
 

5.5.1 MPIO drivers 
VIOS includes a basic MPIO driver, which has been the default instead of the RDAC driver since 
November 2008.  The MPIO driver can be used with any storage subsystem that VIOS supports and is 

http://www.ibm.com/support/docview.wss?uid=nas13b3ed3c69d4b7f25862576b700710198
http://www-912.ibm.com/n_dir/nas4apar.NSF/c79815e083182fec862564c00079d117/02327e067599839e86257659003c6d66?OpenDocument
http://www-912.ibm.com/n_dir/nas4apar.NSF/c79815e083182fec862564c00079d117/02327e067599839e86257659003c6d66?OpenDocument
http://www-912.ibm.com/n_dir/nas4apar.NSF/c79815e083182fec862564c00079d117/02327e067599839e86257659003c6d66?OpenDocument
http://www.redbooks.ibm.com/abstracts/sg247938.html?Open
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included in a default install.  In this case, configuration is required only on the storage subsystem in order 
to connect a single set of LUNs to both of the ports on a FC adapter owned by VIOS. 
 
VIOS also supports the Subsystem Device Driver – Path Control Module (SDDPCM) for certain storage 
subsystems.  The Storwize V7000 San is one of these.  To find out whether a particular storage system 
supports SDD-PCM for VIOS, refer to its interoperability matrix on the SDDPCM Web site: 
http://www.ibm.com/support/docview.wss?uid=ssg1S4000201 Note that there are separate support 

statements for AIX and VIOS.  If SDDPCM is supported on your storage subsystem for VIOS, download 
and install the driver following the instructions in the Multipath Subsystem Device Driver User's Guide 
found at that same site. 

5.6 Using an external DVD drive with VIOS and IBM i   
 
VIOS can virtualize an external USB DVD drive to IBM i.  The DVD drive becomes physically available 

only to VIOS.  It is then assigned to an IBM partition using the FSM as described in the Moving the 

DVD drive to another virtual server using FSM section.  Note that cd0 is the name of the physical 

DVD drive as assigned by VIOS. 
 
When the DVD drive must be reassigned to another IBM i LPAR on the same node, the OPTxx device in 
IBM must first be varied off.  Then the cd0 device can be assigned to the second LPAR using the same 

method described in the Moving the DVD drive to another virtual server using FSM section. 

 
When the DVD drive is assigned to VIOS, you need to perform the following steps: 
 

 SSH to VIOS on the correct node and sign in with padmin (as the user ID) 

 Type cfgdev and press Enter 

 Assign the DVD drive to the correct IBM i partition as described in the Moving the DVD 

drive to another virtual server using FSM section.  

 Vary on the OPTxx device in IBM i 
 
VIOS uses a USB 2.0 driver for physical access to the DVD drive.  As a result, all client LPARs using the 
DVD drive as a virtual optical device from VIOS can perform faster reads and writes operations.  One 
benefit of this enhancement is shorter install duration for the IBM i Licensed Internal Code (LIC) and 
operating environment, as well as Program Temporary Fixes (PTFs). 

5.6.1 Writing to DVD-RAM media  
VIOS has the capability to write to DVD-RAM media.  For IBM i as client of VIOS all DVD-RAM operations 
that are supported by IBM i are available when using this drive. This improvement allows IBM i to perform 
small saves and restores (up to 4.7 GB) using this DVD drive. 
 

5.7 Creating multiple Virtual SCSI adapters per IBM i partition 
IBM i has a restriction of 16 disks (LUNs) per VSCSI adapter. It is possible to create multiple Virtual SCSI 
client adapters per IBM i partition on a node to allow:   

 More than 16 disk and 16 optical devices can be virtualized by VIOS per IBM i partition 

 Disk and optical devices can be configured on separate Virtual SCSI adapters 
 
With FSM, you can manually create more adapter pairs, but you must use the VIOS CLI to assign drives 
to any additional adapters. 

http://www.ibm.com/support/docview.wss?uid=ssg1S4000201
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5.7.1 Creating Virtual SCSI adapters using FSM 
When using an FSM to manage Power nodes, you can create virtual SCSI adapters to use between VIOS 
and the IBM i client partition.  In this section you will see how to create server adapter and client adapter 
pair. 
 
Create Client SCSI Adapter 
Perform the following steps to create a client SCSI adapter: 
 

 On the Power Systems Resources tab of the FSM, click the Virtual Servers link, then select the 
checkbox next to the IBM i client you are configuring 

 Right click and select System Configuration -> Manage Profiles 

 Select a profile and select Actions->Edit… to edit the profile 

 Click the Virtual Adapters tab and then click Actions -> Create Virtual Adapter -> SCSI 
Adapter… 

 Note the Adapter ID assigned and click the checkbox for “This adapter is required for virtual 
server activation”   

 Select the VIOS server from the Server partition list. 

 Click the System VIOS Information button to see the currently defined adapters on the server.  
You need to choose an available adapter number.  Then close that window. 

 Specify a Server Adapter ID (remember it for the next step) and click OK to create the client 
Virtual SCSI Adapter  

 
Create Server SCSI Adapter 
Perform the following steps to create a server SCSI adapter. 
 

 Select the checkbox next to the VIOS server. Click Actions-> System Configuration -> Manage 
Virtual Server 

 Click the Storage Adapters tab and then click the Add button.   

 Specify the Adapter ID you used above and an adapter type of SCSI 

 Use the list to select the IBM i client partition you want to use  

 Specify the adapter ID you created above as the connecting adapter ID and click OK to create 
the server Virtual SCSI Adapter 

 These changes are dynamically applied to the VIOS server, so you need to also update the 
server’s profile. On the right hand side of the window, click the Tasks button and Save Current 
Configuration option. Then select to overwrite the existing profile to update the VIOS profile 
with these same changes. 

 Close the Manage Virtual server tab.   
 

5.7.2 Creating Virtual SCSI adapters using the VIOS CLI 
If you choose to create additional Virtual SCSI client adapters using the VIOS command line do the 
following commands: 

 Log into VIOS with padmin or another administrator user ID. 
 

You need to determine the partition ID VIOS is using. To display the current names and IDs of all existing 
partitions, use the following command: 
 

 lssyscfg -r lpar -F "name,lpar_id" 

 If the IBM i partition is not activated, refer to the following example that adds a new Virtual SCSI 
client adapter in slot 5 of IBM i partition “test,” connecting to a server adapter in the next 
available slot in the partition named “VIOS”: 

 
o chsyscfg -r prof -i "name=test,virtual_scsi_adapters+=5/client/1/VIOS//1" 
o The corresponding server adapter in VIOS is created automatically. 
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 If the IBM i partition is running, refer to the following example that creates a new Virtual SCSI 
client adapter in slot 5 of IBM i partition “test”, connecting to a server adapter in the next 
available slot  in partition “VIOS”: 

 
o chhwres -r virtualio --rsubtype scsi -p test -o a -s 5 -a "adapter_type=client" 
o The corresponding server adapter in VIOS is created automatically. 
 

 Notice that there are three variables in the previous commands: the name of the IBM i partition, 
the new slot for the Virtual SCSI client adapter, and the name of the VIOS partition.   

 
To display which virtual slots have been already been used, by partition and adapter, use: 
 

 lshwres -r virtualio --rsubtype slot --level slot (notice the double dashes) 

 The type of adapter is shown on the middle of each line. The slot numbers are shown at the 
beginning of each line. 

 

5.7.3 Mapping storage to new Virtual SCSI adapters using the VIOS CLI 
 
After creating a new Virtual SCSI client adapter for IBM i and the associated server adapter for VIOS, you 
can assign additional LUNs to IBM i by mapping them to the new server adapter in VIOS.   
Note that even if you create a new Virtual SCSI adapter on the FSM,  that interface will not allow you to 
choose which VSCSI adapter to use  to map LUNs or optical devices to IBM i.  Only map up to 16 disks to 
a client partition when using the  FSM interface.  More LUNs are allowed,to be mapped from FSM 
because AIX supports 256, but IBM i does not.  
 
The assignment of LUNs and optical devices to IBM i using a Virtual SCSI adapter other than the 
first virtual adapter must be done explicitly using the VIOS CLI (telnet or PuTTy® to the VIOS IP 
address). 
 
To display LUNs (or other physical volumes) that are available to be assigned to IBM i on the node, use 
the following list physical volume command: 
 

 lspv -avail 
 
To display all existing virtual resource mappings by Virtual SCSI server adapter in VIOS (vhostX) and 
client partition, as well as any newly created Virtual SCSI server adapters, use the following list mappings 
command: 
 

 lsmap -all | more 

 Press the Space bar key to move forward one screen of data at a time and the Down Arrow 
key for one line at a time.  Enter q to quit. 

 
Any new Virtual SCSI server adapters will have no resources mapped to them.  Assuming that “hdisk7” 
is an available LUN and “vhost1” is a newly created Virtual SCSI server adapter, use the following 
command to make hdisk7 available to IBM i: 
 

 mkvdev -vadapter vhost1 -vdev hdisk7 
 
The lsmap command above will also show whether a physical DVD drive in the node (typically cd0) is 
already assigned to a client other partition.  If so, a vtoptX device will exist under a Virtual SCSI server 
adapter (vhostX).  Skip this step if the DVD drive is not already assigned to a client partition.  To map the 
DVD drive to a different Virtual SCSI adapter, first delete the correct existing vtoptX device (such as 
“vtopt0”) using the following command: 
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 rmdev -dev vtopt0 
 
Next, assign the physical optical device (such as cd0) to the IBM i partition using the correct separate 
Virtual SCSI adapter (such as “vhost 1”) using the following command: 

 mkvdev -vdev cd0 -vadapter vhost1 
 
To map a file-backed optical device to a new Virtual SCSI adapter (such as “vhost 1”), using the 
following command : 

 mkvdev -fbo -vadapter vhost1 

5.7.4 Mapping storage to new Virtual SCSI adapters using the FSM 

 On the Manage Power Systems Resources page, select the Power node 

 Right click on it and select to System Configuration -> Virtual Resources -> Manage Virtual 
Storage 

 Query the VIOS server you are using.   

 Click on the Physical Volumes tab.  

 Select an hdisk from the list that is not currently assigned to a virtual server and click on Modify 
assignment button. 

 Look near the top of the screen for the New virtual server assignment pulldown.  Select the 
virtual server and the correct associated virtual SCSI adapter number (if present) to map the 
storage to.  If only 1 vSCSI adapter is defined in a virtual server, no vSCSI adapter number will be 
shown. 

 Next click OK. 

 Repeat the process for each hdisk that you want to map.   

 When you exit the virtual storage pane, the hdisks will be mapped to the associated adapter. 

5.7.5 Removing Virtual SCSI adapters using the VIOS CLI 
 
The VIOS command line is also used to remove Virtual SCSI client adapters from an IBM i partition.  Note 
that removing a Virtual SCSI client adapter from IBM i will make any devices it provides access to 
unavailable.  As mentioned above, to check which devices in VIOS are mapped to which Virtual SCSI 
server adapter, and therefore which client partition, use the following command on the VIOS command 
line: 

 lsmap –all | more 

 Press the Spacebar key to move forward one screen of data at a time and the Down Arrow 

key for one line at a time, and enter q to quit . 

 
To remove a Virtual SCSI client adapter when the IBM i partition is not activated, refer to the following 
example which removes the client adapter in slot 5 of IBM i partition “test”: 

 chsyscfg -r prof -i "name=test,virtual_scsi_adapters-=5/////" (note the minus sign before the 
equal sign) 

 
To remove a Virtual SCSI client adapter when the IBM i partition is running, refer to the following example 
which removes the client adapter in slot 5 of IBM i partition “test”:  

 chhwres -r virtualio --rsubtype scsi -p test -o r -s 5 

5.7.6 Removing virtual SCSI adapters using FSM 
Note that removing a Virtual SCSI client adapter from IBM i will make any devices it provides access to 
unavailable.  

 Log into FSM with USERID as the user ID or another user ID 

 On the Manage Power Systems Resources tab of the FSM, select the node from the list of 
hosts and select the checkbox next to the IBM i virtual server you are configuring 

 Click System Configuration -> Manage Profiles  
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 Select a profile and then click Actions->Edit… to edit the profile 

 Click the Virtual Adapters tab, select the adapter and then click Actions -> Delete 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6 VIOS and IBM i installation and configuration 
On Foundation configurations, VIOS is always installed on all Power nodes in the order.  IBM i can also 
be preinstalled when ordered as the primary operating system on the primary Power node.  This section 
details the case for a secondary Power node or a Build to Order (BTO) configuration. 

6.1 Obtain the VIOS and IBM i installation media and fixes 
 
VIOS is part of IBM PowerVM Editions (formerly known as Advanced Power Virtualization) and is required 
in the IBM i on POWER node environment.  Work with your local sales channel to ensure that PowerVM 
(Standard or Enterprise Edition) and the latest fix pack are part of the POWER node order.  Refer to the 
Flex System Interoperability Guide (FIG), for current configuration options at:  
http://www.ibm.com/common/ssi/cgi-

http://www.ibm.com/common/ssi/cgi-bin/ssialias?subtype=WH&infotype=SA&appname=STGE_WZ_WZ_USEN&htmlfid=WZL12345USEN&attachment=WZL12345USEN.PDF
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bin/ssialias?subtype=WH&infotype=SA&appname=STGE_WZ_WZ_USEN&htmlfid=WZL12345USEN&attachment=W

ZL12345USEN.PDF 
 
Work with your local sales channel to obtain the IBM i install media and the latest PTF package.  The 
minimum supported release of IBM i is i6.1.1.  i6.1 can not be ordered preinstalled from IBM 
manufacturing, but it is supported with a manual install.  PTFs can also be obtained from IBM Fix Central: 
http://www-912.ibm.com/eserver/support/fixes/  

6.2 Install PuTTY (optional) 
 
As mentioned above, FSM is used for both LPAR and virtual resource management in this environment.  
To install and configure VIOS, and later to save or restore it, a Telnet session to the CMM or to VIOS is 
required.  Use the PuTTY application any time a Telnet session is mentioned in this paper.  PuTTY 
provides better terminal functionality than the Telnet client included with Windows and can be 
downloaded at no cost the following URL: 
http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html   

6.3 Installing and configuring additional VIOS servers (if needed) 

6.3.1 Powering on the node from FSM 

 On the Manage Power Systems Resources tab on the FSM, select the node from the list 

of hosts 

 Right click on the node and select Operations -> Power On 

 View the node’s system reference codes from: 

o Right click on the Power node and select Service and Support-> Reference Code 

history 

o The node should come up to Standby mode, ready to start virtual servers. 

6.3.2 Installing a new VIOS  
The instructions in this section explain how to install VIOS on the POWER node.  VIOS may be pre-
installed on the internal SAS drive of your node or on a SAN LUN, but you may have the need to install 
another VIOS server for redundancy.  
 
The POWER node provides the option for two integrated SAS drives on the node.  It is recommended to 
order both integrated drives on the node, install VIOS on the first SAS drive and mirror the entire install to 
the second drive.  But this is not a requirement. A SAN LUN can also be used for VIOS.  In the case of a 
full-wide node, only one VIOS server can use the SAS drives since there is a only a single controller for 
them.   

6.3.3 Creating a VIOS virtual server using FSM 
You choose which virtual server is for VIOS.  Maybe you will have two for redundancy.  
Refer to the “Create the IBM i Virtual Server using ” section, but use the procedure to create a VIOS 
virtual server first.  Then follow the steps in the “Opening a VIOS console using ” section followed by 
either the “Installing VIOS from DVD” section or the “Installing VIOS from NIM” section to proceed with the 

VIOS install.  Proceed with the “Completing the VIOS install” section.   

6.3.4 Opening a VIOS console using FSM 
To start a console in FSM: 

 Select the virtual server from the Manage Power Systems Resources virtual server list  

 Right click on the virtual server and click Operations -> Console Window -> Open Terminal 
Console 

http://www.ibm.com/common/ssi/cgi-bin/ssialias?subtype=WH&infotype=SA&appname=STGE_WZ_WZ_USEN&htmlfid=WZL12345USEN&attachment=WZL12345USEN.PDF
http://www.ibm.com/common/ssi/cgi-bin/ssialias?subtype=WH&infotype=SA&appname=STGE_WZ_WZ_USEN&htmlfid=WZL12345USEN&attachment=WZL12345USEN.PDF
http://www-912.ibm.com/eserver/support/fixes/
http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html
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 Log into the console using the FSM user ID and password. 

 Log into VIOS using the padmin user ID and password. 

6.3.5 Starting the VIOS virtual server 
To start the new VIOS virtual server in FSM: 

 Select the virtual server from the Manage Power Systems Resources virtual server list  

 Right click on the virtual server and click Operations -> Activate -> Profile 

 You are prompted with an Advanced button, where you can set the boot mode to stop at 
SMS just for this boot. Do that, clicking OK to start the activation and then follow the steps 
below. 

6.3.6 Accessing the System Management Services (SMS) menu 

 On the console for VIOS, as soon as the PFW screen starts to load, press 1 quickly to enter 
the System Management Services (SMS) menu   

 If you miss the opportunity to press 1, PFW will attempt to boot the partition from the default 
boot device.  If VIOS is not yet installed, the boot will fail and the SMS menu will eventually 
be displayed   

 
 

 Installing VIOS from DVD 
 

 On the main SMS menu, click 5.Select Boot Options 

 Click 1.Select Install/Boot Device   

 Click 3.CD/DVD   

 Click 6.USB   

 Select Option 1 to choose the USB CD-ROM   

 Click 2.Normal mode   

 Click 1.Yes to exit the SMS menus and start the VIOS install.  Allow approximately 5 minutes 
for the install program to load from the media. 

6.3.7 Installing VIOS from NIM 
 

 First set up the NIM server for providing the VIOS image (not covered in this document) 

 On the main SMS menu, click the menu option 2.Setup Remote IPL (Initial Program Load)   

 Select the port to use (for most scenarios, port 1)   

 Click IPv4. 

 Select 1.BOOTP as the Network Service   

 Select 1.IP Parameters to fill in the necessary data.  Fill in the following information for the IP 
Parameters by selecting the item number and typing in the data: 

o Client IP Address: The IP address you have chosen for this VIOS partition. 
o Server IP Address: The NIM server's IP address. 
o Gateway IP Address: The gateway IP for this VIOS partition. 
o Subnet Mask: The correct subnet mask for the network segment of which VIOS is going 

to be a part. 

 After entering the necessary information correctly, press the Escape key to go back a page and 
click 3.Ping Test 

 Click 1.Execute Ping Test to test the connection.  If the ping test is successful, press the M key 
to go back to the SMS main menu and continue the install.  (If the ping test is not successful, 
check the network settings on the BladeCenter)   

 On the SMS main menu, click 5.Select Boot Options   

 Click 1.Select Install/Boot Device  

 Click 6.Network for the Device Type 
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 Click 1.BOOTP as the Network Service   

 Select the port that you just configured above (for most scenarios, port 1)  

 Click 2.Normal Mode Boot   

 Click 1.Yes to start the install (this will exit the SMS menus and the install image will start 
downloading from the NIM server) 

6.3.8 Completing the VIOS install 
 
This section applies to installing from DVD or NIM: 
 

 As soon as the first "Welcome to the Virtual I/O Server" screen has disappeared, enter 1 on the 
prompt to confirm this terminal as the console and press Enter (the number will not appear on the 
screen)   

 Enter the correct number option for the language you want to use during install   

 On the Welcome to BOS menu, click Change/Show Installation Settings and Install   

 Click option 2 to verify that the correct disk unit is selected for installation.  The SAS drive 
internal to the node is detected as hdisk0, whereas any LUNs attached to VIOS are  detected as 
hdisk1, hdisk2 and so on.    

 Click option 0 twice to begin installation. 

 After the installation has been completed and VIOS has been rebooted, log in with the default 
administrator user ID, padmin.   

 You will be prompted to enter and verify a password for the padmin user ID. 

 Hit enter on the prompt to accept licensing <a>.  

 Enter license –accept to accept the VIOS license agreement.  

6.3.9 Mirroring of VIOS 
Because VIOS provides storage, optical and networking I/O resources to IBM i, any IBM i LPAR on the 
node depends on VIOS to be operational.  Therefore, it is strongly recommended to employ disk 
protection for the VIOS installation. 
 
When IBM i is implemented on a POWER node where there is a single internal SAS drive on the node 
itself, that can be used for the VIOS installation.  VIOS can then be mirrored to a LUN on the SAN.  
Alternatively, you can forgo the internal drive on the node and install VIOS completely on the SAN, 
leveraging its RAID disk protection.  If VIOS is installed entirely on the SAN, it is strongly recommended to 

use multipath IO (MPIO) to access the LUNs, as discussed in “Multi-path I/O (MPIO)” section.  When 

IBM i is implemented on a POWER node where there are two drives available on the node, those can be 
used for VIOS installation and mirroring.   
 
Note that if mirroring is used, the correct method to achieve a redundant VIOS installation, regardless of 
the type and location of disks used, is to install VIOS on one drive and then mirror to the second.  The 
incorrect method is to install VIOS on both drives at the same time.  This latter method would not result 
in two copies of all VIOS files and two bootable drives.  Note also that mirroring VIOS does not protect 
any IBM i or other client partition data; it protects only the system volume group, or storage pool called 
rootvg. 
 
After installing VIOS, perform the following steps to configure mirroring:     

 On FSM select the VIOS virtual server from the Manage Power Systems Resources virtual 
server list, right click on the virtual server and click Operations -> Console Window -> Open 
Terminal Console 

 Log into the console using the FSM user ID and password. 

 Log in with padmin as the user ID. 

 Identify a second available hdisk for the mirrored pair, such as hdisk1 using the lsdev | grep 
hdisk command. 
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 Add that hdisk to the rootvg with the command, chsp –add hdisk1.  The command assumes 
rootvg if a storage pool is not specified 

 Enable mirroring using the command, mirrorios –f –defer hdisk1.  When possible, reboot 
VIOS to complete the mirroring.  For an immediate reboot, omit the –defer option 

The mirrorios command accomplishes three tasks: it creates a copy of all logical volumes (except for the 
system dump volume) in rootvg on the second hdisk, makes the second hdisk bootable and changes the 
VIOS bootlist to include it.  After completing mirroring mirroring is complete, you can verify that all logical 
volumes in rootvg have a copy on both hdisks with: 
 

 lsvg –lv rootvg.  Check for the number 2 in the PVs column 
 
You can verify that the VIOS bootlist now includes the second hdisk with: 
 

 bootlist –mode normal –ls.  The output should include both the hdisks. If both hdisks are not 
shown on the bootlist, then do a bootlist -mode normal hdisk0 hdisk1 or whichever hdisks you want to 

use. 

6.3.10 Configure networking in VIOS (if necessary) 
 
If you installed VIOS from a NIM server, basic networking is already configured.   
 
If you installed VIOS from DVD, perform the following steps to configure basic networking in VIOS: 
 

 On FSM select the VIOS virtual server from the Manage Power Systems Resources virtual 
server list, right click on the virtual server and click Operations -> Console Window -> Open 
Terminal Console. 

 Log into the console using the FSM user ID and password. 

 Log into the VIOS using the padmin user profile. 

 Use the lsdev | grep en command to identify the correct network device.  In most cases, the first 
Ethernet adapter port (ent0) is used. 

 The network interface that corresponds to ent0 is en0 

 To configure the correct enX interface: enter cfgassist 

 Use the arrow keys to move down to the VIOS TCP/IP Configuration and press Enter 

 Select the enX port that you want to configure and press Enter 

 Fill in the host name, IP address, network mask, gateway, domain name and DNS IP address 
values (as required) and press Enter. 

 You should see the word running in the upper left hand corner. If successful, this will change to 
OK. If unsuccessful, error messages is shown. Press F3 or Esc-3 to return to the previous menu 
and make corrections, or press F10 or Esc-0  to exit to the command line. 

 Test the configuration by pinging the gateway or another address that should be accessable. 

 Write down the name of the physical adapter (such as ent0), as you will need it later to configure 
the virtual Ethernet bridge (as explained in the “Error! Reference source not found.” section.  If 
you forgot to write it down, enter lstcpip –num to find which interface was configured. 

 
Several VIOS commands are available to check, remove or change the networking configuration.  For 
example, to list the current VIOS network configuration, use the following command: 
 

 lstcpip –stored 
 
To check that routing is configured correctly, use the following command: 
 

 lstcpip –routtable  
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To remove the VIOS network configuration and start again (this command should be executed on the 
SOL console for VIOS that the CMM provides), use the following command:  
 

 rmtcpip –f –all  
Ensure that you use the –f which forces the removal or the command may hang the session. 
 
Note: Entering the above command from a Telnet or PuTTY session will disconnect the session as they 
are using the TCP address as the destination for the session. 
To learn about all available options for these commands and the rest of the VIOS network configuration 
commands, refer the Network commands section of the VIOS command reference in the IBM Systems 
Information Center at:  
http://publib.boulder.ibm.com/infocenter/systems/scope/hw/index.jsp?topic=/iphb1/iphb1_vios_commands
list.htm 

6.3.11 FSM update of the system firmware on the FSP and Mezzanine 
adapters on the POWER node (if necessary) 

System firmware on a Power node can be updated through the FSM.  To view firmware levels and update 
firmware, select the node from the list of hosts on the Manage Power Systems Resources page.  Then 
click Release Management -> Power Firmware Management from the Action button.  You may have to 
use the Gather Target information button.  
 
To update the firmware from the FSM Home page, click on the Compute Nodes: check and update 
firmware link.  Point to the node using the wizard steps.  This assumes internet access from the FSM. If 
you do not have internet access from the FSM, you can separately download updates from Fix Central 
and import them into the FSM for installation.  
 

6.3.12 Update VIOS (if necessary) 

6.3.12.1 Using the VIOS CLI 

Updates to the VIOS software are released as fix packs, service packs or rarely for important individual 
fixes, interim fixes (ifixes).  A fix pack is cumulative and contains all fixes from previous fix packs.  Each 
fix pack also includes information on the level of VIOS to which it will update the system.  To find your 
current VIOS level, use the following command in a VIOS console session: 
 

 ioslevel 
 
Then compare your current level with the level documented in the latest fix pack.  To find the latest VIOS 
fix pack, visit http://www14.software.ibm.com/webapp/set2/sas/f/vios/download/home.html.  To install a fix 
pack, service pack or ifix, click on it on the VIOS Downloads page above and follow the instructions in 
the README file for that update. 

6.3.12.2 Update VIOS using the FSM  

 On the FSM Manage Power Systems Resources tab, expand Hosts and right click 

on the VIOS virtual server. 

 Click Release Management -> Show and Install updates.  This assumes that the 

FSM has internet access to IBM Fix Central and that VIOS is active. 

 If updates exist, you will shown an option to install them.  You need to plan for a 

VIOS reboot, which implies that the client virtual servers will need to be shutdown. 

 Also look for options to update the firmware on the Mezzanine adapters. 

http://publib.boulder.ibm.com/infocenter/systems/scope/hw/index.jsp?topic=/iphb1/iphb1_vios_commandslist.htm
http://publib.boulder.ibm.com/infocenter/systems/scope/hw/index.jsp?topic=/iphb1/iphb1_vios_commandslist.htm
http://www14.software.ibm.com/webapp/set2/sas/f/vios/download/home.html
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6.3.13 Displaying the current microcode level of the expansion 
adapters on the node: 

Mezzanine firmware levels can be seen using the following command from the VIOS command 

line: 
 lsfware –all  (list firmware) 

 The device names shown can be fcs0 or similar for FC adapters. Notice a result similar to fcs0 
7710322577107501.03150150505 

 

6.3.14 Configure the Virtual Ethernet bridge (using FSM) - 
Express/Standard configurations 

As discussed previously, IBM i does not have direct access to any physical network adapters on the 
POWER node.  Instead, it uses a Virtual Ethernet adapter to connect to VIOS and any other virtual 
servers on the same node over a Virtual LAN (VLAN).  VIOS in turn connects to the external LAN by 
using the Ethernet ports on the expansion card and an Ethernet I/O module in the chassis.  The VLAN is 
bridged over to the external physical LAN using a Virtual Ethernet bridge in VIOS.  The Virtual Ethernet 
bridge associates a VLAN with a physical network port in VIOS.  This Layer-2 bridge allows externally 
routable IP addresses to be assigned to the IBM i partition for regular network communications.  

 To configure the Virtual Ethernet bridge: 

 From the Manage Power Systems Resources page, open the list of virtual servers and right-
click on the VIOS you are configuring 

 Click System Configuration -> Manage Virtual Server and click the Network tab on the left 
hand navigation bar. 

 Select the adapter port to configure (typically the first port) and click the Edit button 

 Select the “Use this adapter for Ethernet bridging” check box in the Shared Ethernet section on 
this page. Also set the priority field based on the following information:  if this VIOS is part of a 
redundant VIOS set, one VIOS has it’s priority set to 1, which makes it the primary VIOS.  The 
backup  VIOS has to have it’s priority set to 2.  If you do not do this, you will cause a network 
storm in your network when the bridging is configured.   

 By default, only one of a pair of redundant VIOS servers handles ALL of the Ethernet traffic for 
the client virtual servers.  This is configured as ha_mode=auto attribute on the shared Ethernet 
adapter (SEA) command.  To better utilize the 10 Gb Ethernet adapters owned by each VIOS 
server, ha_mode=sharing was implemented.  The virtual Ethernet traffic handling is negotiated 
between the VIOS servers as additional LANs are configured, but there is a catch. You have to 
enable IEEE 802.1Q VLAN tagging on each virtual Ethernet LAN for this to work.  A different port 
VLAN ID (PVID) is not enough.  You don’t have to specify an explicit VLAN tag, just enable the 
tagging support on each virtual Ethernet adapter. 

Note: The Edit option will not allow you to set bridging on an active adapter. You must shutdown VIOS or 
add a new adapter. 

6.3.15 Configure the Virtual Ethernet bridge (using FSM) - 
Enterprise/multi-chassis configurations 

These configurations contain redundant chassis Ethernet switches.  This requires some separate 
configuration changes as follows:  
 
First, you need to shut off the redundant Internal ports on the second EN4093 Ethernet switch in IO Bay 2.  
Use the Chassis Management Module’s component IP prompt to determine the switch’s IP address. 
 
To shut off internal ports on the switch, use an SSH interface to the switch’s address and make sure you 
are in iscli mode. Then run the following: 
en 
conf t 
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interface port INTA1-INTB14 
shutdown 
 
On VIOS, determine the physical Ethernet ports that are being seen: 

lsdev | grep ent   This should show you a list of physical and virtual Ethernet ports along with a 
Shared Ethernet Adapter (SEA).  Locate the first 2 physical ports, typically ent0 and ent1. 

  
Now configure a link aggregation between those first two physical ports: 
 cfgassist -> Devices -> Link Aggregation Adapter -> Add a  Link Aggregation Adapter -> 

then enter ent0,ent1 for the Target ADAPTERS field and hash_mode=src_dst_port for the 
ATTRIBUTES field.  Then hit enter. 
Or use this command: 
mkvdev –lnagg ent0,ent1 –attr hash_mode=src_dst_port 
 

This should create another ent# for your link aggregate adapter. 
 
Now make a shared Ethernet adapter (SEA) that bridges the virtual Ethernet adapters (ent4 and ent5) to 
the link aggregate adapter (ent# created above):  
 mkvdev –sea ent# -vadapter ent4,ent5 –default ent4 –defaultid 4091 
 
This should create another entY for your  SEA 
 
Now assign your IP address to the SEA: 

cfgassist -> VIOS TCP configuration -> choose the en# of the link aggregation port -> enter the 
field parameters for your IP configuration and hit enter. 
Or use this command: 
mktcpip -hostname <VIOS hostname> -inetaddr <VIOS IP address> -interface enY –netmask 
<subnet mask> –gateway <gateway IP address> –nsrvaddr <DNS server IP address> 
-nsrvdomain <domain name> –start 

 
Test the IP by pinging another address on the same subnet. 
 
To turn the internal ports back on: 
en 
conf t 
interface port INTA1-INTB14 
no shutdown 
 
Note: By default, only one of a pair of redundant VIOS servers handles ALL of the Ethernet traffic for the 
client virtual servers.  This is configured as ha_mode=auto attribute on the shared Ethernet adapter (SEA) 
command.  To better utilize the 10 Gb Ethernet adapters owned by each VIOS server, ha_mode=sharing 
was implemented.  The virtual Ethernet traffic handling is negotiated between the VIOS servers as 
additional LANs are configured, but there is a catch. You have to enable IEEE 802.1Q VLAN tagging on 
each virtual Ethernet LAN for this to work.  A different port VLAN ID (PVID) is not enough.  You don’t 
have to specify an explicit VLAN tag, just enable the tagging support on each virtual Ethernet adapter. 
Note: The Edit option will not allow you to set bridging on an active adapter. You must shutdown VIOS or 
add a new adapter. 
 

6.3.16 Memory recommendations for VIOS and the Power Hypervisor 
 
A minimum of 4 GB of memory is recommended for VIOS with an IBM i client.   
To change the amount of memory that VIOS is using from FSM:  

 From the Manage Power Systems Resources page 

 Open the list of virtual servers and right-click the VIOS partition. 
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 Click System Configuration -> Manage Virtual Server and then click the Memory tab. 

 Change the assigned memory and click Apply. 

 If this is a permanent change, then click the Tasks button on the right hand side and select Save 
Current Configuration option. Then select to overwrite the existing profile to update the VIOS 
profile with this same change. 

 Close the Manage Virtual server tab.   
 
Note that if the new assigned value is higher than the maximum memory value, a restart of VIOS is 
required to activate the change.  Before restarting VIOS, gracefully shut down any client partitions on the 
node. 
 
You should also plan on leaving at least 512 MB of memory unassigned for use by the system firmware 
(the POWER Hypervisor).  There is no way to view the amount of memory used by the POWER 
Hypervisor through the FSM. 

6.3.17 Processor recommendations for VIOS 
 
For most IBM i on node configurations, it is recommended to configure VIOS with 0.5 processor units and 
one assigned (or desired) virtual processor.  If VIOS is hosting three or more IBM i or other partitions, 
consider changing its processor allocation to one dedicated processor.  Note that you must reboot VIOS 
to change from shared to dedicated processors. 
 
Note: The Workload Estimator (WLE) can be used to estimate the VIOS that is hosting multiple workloads 
by using the following link: http://www-304.ibm.com/systems/support/tools/estimator/index.html 

6.3.18 End to end LUN mapping using FSM 
You may need to map the VIOS hdiskx back to their associated LUNs for debug, there is an FSM 
interface to help do that:  

 On the Manage Power Systems Resources page, select the Power node 

 Right click on it and select to System Configuration -> Virtual Resources -> Manage Virtual 
Storage 

 Query the VIOS server you are using.   

 Click on the Physical Storage tab.  

 Slide the columns over to see the full values of the Physical Location Code column.  You should 
see something like this:  

 W500507680210976C-L10000  The L1 is the LUN number, or on the Storewise V7000 the SCSI-
ID (seen from the logical drive properties on the V7000).   

 There is a PTF for IBM i (i7.1 SI45124) that can display the LUN from the IBM i WRKHDWRSC 
*STG command. 

6.4 IBM i install and configuration 
FSM defaults the load source and alternate initial program load (IPL) adapters to the VSCSI client 
adapter in the IBM i partition.   
 
If you choose to use shared processors for IBM i, FSM defaults to assigning 0.1 times the number of 
processors you select as shared processor units and the whole number of processors you select as 
virtual processors.  For example, if you select four shared processors, FSM initially assigns 0.4 
processing units and 4 virtual processors to the partition.  Also note, that by default, shared processor 
partitions are configured as uncapped.  When assigning memory during partition creation, you are 
selecting the assigned or desired amount for the partition.  FSM automatically assigns minimum and 
maximum values.  The default processor and memory configuration can be changed by working with the 
partition properties after creation. 
 

http://www-304.ibm.com/systems/support/tools/estimator/index.html
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The minimum recommended amount of memory for an IBM i client partition on the POWER node is 1 GB. 
This is really minimum and should be set higher.  The actual memory and processor values should be 
sized individually for each IBM i workload using the Workload Estimator, available at http://www-
304.ibm.com/systems/support/tools/estimator/index.html. 
 

6.4.1 Create the IBM i Virtual Server using FSM 
Perform the following steps to create the IBM i virtual server. 
 

 On the welcome page, click the Hosts.    

 Right-click on the host on which you want to create the IBM i partition (virtual server) and 
click System Configuration -> Create Virtual Server.  Virtual server ID will default to the 
next available virtual server number. 

 Enter a name for the virtual server.   

 Select Environment: IBM i. If you plan to use partition suspension, check that box and then 
click Next. 

 Set the desired memory value in GB and click Next.  

 Set the desired processor configuration and click Next.   

 Click the check box for the first virtual Ethernet adapter and click the Edit button.  Set the port 
virtual ethernet (VLAN) to 1 which should be the default and click OK. 

 Click Next   

 Select Yes, Automatically manage the virtual storage adapters for this Virtual Server 
and then select Physical Volumes. VIOS will be queried to see which hdisks are available.  
The list will be presented to you.  Select the hdisks that you want the IBM i partition to use. 
Click Next.   

 If you plan to use an external DVD drive or the VIOS supplied virtual media library, select 
those devices on the next screen. Multiple iso files can be selected for sequential access.  If 
you are not seeing either of these devices, follow the steps in sections “Error! Reference 
source not found.” and “Moving the DVD drive to another virtual server using FSM”.  Once 
those steps are completed, restart the create virtual server wizard. 

 Choose the adapters you want to use for physical I/O  (typically none) and click Next 

 Select the load source adapter (its typically the virtual SCSI adapter), alternate restart device 
(if any, its typically the virtual SCSI adapter) and the FSM will supply the console and click 
Next.  

 Review the summary and click Finish.     

6.4.2 Increasing the number of virtual adapters in the IBM i partition 
The default number of virtual adapters for a client partition is 10.  VIOS uses the slots 0 to 10, so these 
are reserved. The overhead of increasing this value is spproximately 1KB of memory per adapter 
increase used by the hypervisor who manages these.  As a rule of thumb, estimate 4-6 virtual adapters 
per client partition being hosted. Total those up and add a few more, since the value can’t be changed 
while VIOS is active.  

6.4.2.1 Using the VIOS CLI 
If there is a need for more than 10,slots you can use the chsyscfg command to increase this value.  

 chsyscfg -r prof -i "lpar_name=<partition3>,max_virtual_slots=<300>"    
The <values> are variables 

6.4.2.2 Using FSM 
If there is a need for more than 10 slots, you can use the FSM GUI to increase this value by performing 
the following steps. 

 On the Manage Power Systems Resources page, click on Virtual Servers. 

http://www-304.ibm.com/systems/support/tools/estimator/index.html
http://www-304.ibm.com/systems/support/tools/estimator/index.html
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 Select the virtual server for VIOS, right-click on the name and click System Configuration -
> Manage Profile. 

 Select the profile name associated with VIOS by clicking on the name.  

 Click the Virtual Adapters tab. 

 Change the value in the Maximum Virtual Adapters field and click OK to accept the 
change.  

 This change will not take affect until the profile is used to activate the VIOS, which implies 
that the VIOS has to be brought down without an automatic restart. 

6.4.3 Configure an IBM i console connection using PCOMM 
 
IBM i requires a Personal Communications 5250 emulator client application to be used as the console for 
the operating system.   If you happen to have the System i Access application installed on a PC, there is 
an emulator option in that product that can be used.  If you don’t have that application on your PC, you 

can download a version from this website: http://www.ibm.com/software/network/pcomm/  Once this 

application is installed, start it up to configure the console using the following steps depending which 
version you are using: 
System i Access: 

 Follow the first 2 blue steps listed on this web page: 

http://www.ibm.com/support/docview.wss?uid=nas137396cfd67d5ef5886256f01000bda5

0 

Personal Communications:  

 Start Programs->IBM Personal Communications->Start or Configure sessions.  

 Click the New Session button. 

 Type of host is iSeries,  then click the Link Parameters button. 

 On the Primary host name or IP address field, enter the IP address of the FSM. Change the Port 
field on the right hand side to 2300.  Then click OK. 

 Then click OK again.   

 An 5250 emulation window will come up and wait for connection from the IBM i. 
 

6.4.4 Install IBM i using the a Network install  
Starting in IBM® i 6.1, you have the ability to perform complete installations and upgrades of IBM® i 
partitions, in addition to loading PTFs or restoring data via a virtual optical image on an image server, all 
without having to manually FTP the data across the network to the individual partitions. This change 
allows for the install of Licensed Internal Code, operating system, licensed programs and PTFs across 
IBM® i partitions from a single image source. This capability is available through PTFs beginning in i 6.1.  
The assumption here is that you have successfully saved a valid IBM i image to a file server that can be 
accessed from your Power node. 
 
The steps to configure and install across a network connection are described in this document: 
ftp://public.dhe.ibm.com/systems/support/power/i/nfs_optical_upgrade.pdf  
 

6.4.5 Install IBM i using the VIOS virtual media library 

VIOS comes with a virtual media library that is preloaded with iso files for the preferred 

operating system that was ordered. This library can be shared across multiple partitions doing 

installs or PTF loads concurrently.  Multiple iso files can be selected for sequential access. 

From FSM 
 On the Manage Power Systems Resources page, select the Power node 

http://www.ibm.com/software/network/pcomm/
http://www.ibm.com/support/docview.wss?uid=nas137396cfd67d5ef5886256f01000bda50
http://www.ibm.com/support/docview.wss?uid=nas137396cfd67d5ef5886256f01000bda50
ftp://public.dhe.ibm.com/systems/support/power/i/nfs_optical_upgrade.pdf
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 Right click on it and select to System Configuration -> Virtual Resources -> Manage Virtual 
Storage 

 Query the VIOS server you are using.   

 Click on the Optical media tab. 

 Select the iso image or images that you want to use and then click Modify Partition assignment 
to assign them to your partition. If you choose more than one image to be mounted, you will need 
to choose the specific image to use during the install process.  

6.4.6 Installing IBM i using an external USB DVD from FSM 

 Place the IBM i installation media in the DVD-ROM drive.. 

 Refer to the “Moving the DVD drive to another virtual server using FSM” section and 

perform the necessary steps to assign the DVD-ROM to the node for this virtual server. 

 In FSM, right-click the IBM i virtual server name and click Operations -> Activate -> Profile to 
activate the virtual server.    

 Select a profile you want to use (such as the default profile) and select the Open a terminal 
window or console session check box.  Then click Advanced. 

 On the Advanced tab, select Manual from the Keylock position list and D-mode from the Boot 
mode list. Then click OK. 

 The welcome page will open and show the status of the virtual server including SRC information. 

 
Note that during installation, the load source and other disk units will be initialized before they are 
included in the system or other ASPs by IBM i.  This initialization time will vary depending on the type of 
storage used.  

6.4.7 Mirroring in IBM i 
With SAN storage, it is not necessary to configure disk protection within the IBM i operating system.  Data 
integrity is provided by the SAN, where each LUN made available to IBM i through VIOS is created from 
multiple physical drives in a RAID array.  However, unlike LUNs physically that are attached to IBM i, 
LUNs that are virtualized by VIOS will not appear in IBM i as parity-protected.  Instead, LUNs from a SAN 
are recognized in IBM i as unprotected DHxxx devices.  

6.4.8 Post-install tasks and considerations 

6.4.8.1 Install IBM i PTFs (if necessary) 
 
Refer to the “Fixes concepts and terms” topic in the IBM i Information Center for the steps to install any 
required PTFs at the following URL:  
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzam8/rzam8fixconcepts1.htm  
Refer to the IBM i Recommended Fixes website to get a list of the latest recommended PTFs at:  
http://www-912.ibm.com/s_dir/slkbase.nsf/recommendedfixes. 
 
Starting in IBM® i 6.1, you have the ability to perform complete installations and upgrades of IBM® i 
partitions, in addition to loading PTFs or restoring data via a virtual optical image on an image server, all 
without having to manually FTP the data across the network to the individual partitions. This change 
allows for the install of Licensed Internal Code, operating system, licensed programs and PTFs across 
IBM® i partitions from a single image source. This capability is available through PTFs beginning in i 6.1.  
The assumption here is that you have successfully saved a valid IBM i image to a file server that can be 
accessed from your Power node. 
 
The steps to configure and install across a network connection are described in this document: 
ftp://public.dhe.ibm.com/systems/support/power/i/nfs_optical_upgrade.pdf  
 

http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzam8/rzam8fixconcepts1.htm
http://www-912.ibm.com/s_dir/slkbase.nsf/recommendedfixes
ftp://public.dhe.ibm.com/systems/support/power/i/nfs_optical_upgrade.pdf
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6.4.8.2 Configure IBM i networking 
 
Refer to the Ethernet topic in the IBM i Information Center to configure IBM i networking for production at:  
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzajy/rzajyoverview.htm.  Note 
that while any virtual Ethernet adapter available in IBM i (as a CMNxx device) can be configured, only 
those on VLANs bridged with a virtual Ethernet bridge by the VIOS server can communicate with the 
external LAN. 

6.4.8.3 Configure Electronic Customer Support (ECS) over LAN 
 
There is no physical modem available to IBM i on POWER node, so ECS over LAN should be configured.  
Refer to the Setting up a connection to IBM topic in the IBM i Information Center at:  
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzaji/rzaji_setup.htm 

6.4.8.4 How to display the IBM i partition System Reference Code (SRC) 

history from FSM 
 

 View the node’s system reference codes from the Manage Power Resources. 

 Right click on the Power node and select Service and Support-> Reference Code history. 

6.4.8.5 Moving the DVD drive to another virtual server using FSM 
Use the following steps: 

 From the client IBM i partition, vary off the OPTxx device. 

 On the FSM Manger Power Resources page, expand Hosts. Select the node and then select the 
IBM i virtual server that is using the DVD.  

 Right click on the name and click System Configuration -> Manage Virtual Server.  

 Click the Media Devices link on the left hand side of the pane. 

 The DVD drive is named cdX. Select it, then click the Remove to remove it from the virtual server. 

 Repeat the steps for the target virtual server using the Add option, then vary on the OPTxx 
device there. 
 

6.5 Moving the virtual media library from one Power node to another 
On the IBM i client virtual server currently using the media repository: 

 Vary off the virtual optical device using option 2 from the wrkcfgsts *dev opt* display 
On the VIOS CLI that is hosting the IBM i: 

 $ oem_setup_env 

 umount /var/vio/VMLibrary   to unmounts the repository 

 varyoffvg mediaRep    to vary off the volume group 

 exportvg mediaRep     to remove the use of the vg from this VIOS  
On the Flex Systems Manager (FSM) for the POWER Nodes: 

 On the Manage Power System Resources tab:  
o Select the Power node where the VIOS is located that is hosting the client VS that is 

using the media repository 
o Right click on the Power node -> System Configuration -> Virtual Resources -> Virtual 

Storage Management. 

 When the window comes up, select the VIOS and click query. 

 When the window comes up, select the virtual media tab, then select the media that is assigned 
to the client virtual server.  

http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzajy/rzajyoverview.htm
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzaji/rzaji_setup.htm
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 If assigned 
o From the Actions box select Modify virtual server assignment. 
o When the window comes up, uncheck the box next to the media, a force option box will 

appear on the bottom of the pane, check that box and click OK.  This will remove the 
virtual media assignment from the IBM i virtual server.  

 If not assigned then close tab 
On the Storwize V7000: 

 Open a browser and enter the IP address of the V7000 cluster management interface: use an 
https for a secure session.  

 Sign on to the V7000 as superuser  
 Navigate to the Volumes by Host pane and locate the MediaRep LUN from the list of volumes. 

You will be changing the host that the virtual media library is assigned to. Right click on the 
volume and select the unmap to host option.   Do not attempt to share the volume between 
two VIOS’s, this will not work due to locking of the volume group. 

 Navigate to Volumes -> Volumes and right click the MediaRep Lun., and choose Map to Host.  
Select the correct host from the drop down menuVerify the selections and then click Apply.   

On the new VIOS that owns the LUN: 

 Open a PuTTy session to the VIOS address using the SSH option.  

 Sign on to the command line interface as padmin. 

 Issue the 'lsdev | grep hdisk' command to see which hdisks are currently known to this VIOS. 
Note the hdisk# numbers.  Be aware of gaps in the numbers as one of these may be used.   

o VIOS will not automatically see the new LUN without a reboot or without running the 
cfgdev command. 

 Issue the 'cfgdev' command to discover the newly mapped LUN.   

 Issue the 'lsdev | grep hdisk' command to locate new drive.  Note the drive number (hdisk#). 

 Issue the 'importvg -vg mediaRep hdisk#'  substituting the hdisk number found above.  This 
command imports the volume group that contains the media repository based on the hdisk 
where it is located. 

 Now mount the imported volume group:  
o mount /dev/VMLibrary /var/vio/VMLibrary  

 The media library is now available to be assigned to a client virtual server. 
On the FSM Manage Power System Resources tab:  

 Select the Power node where the VIOS media repository is located:  

 Right click on the Power node -> System Configuration -> Virtual Configuration -> Virtual Storage 
Mangement. 

 When the window comes up, select the VIOS and click query. 

 When the window comes up, select the virtual media tab, then select the media that is to be 
assigned to the IBM i client virtual server.  

 From the Actions box select Modify virtual server assignment. 

 When the window comes up, check the box next to the media, and click OK.   
 This will add the virtual media assignment to the IBM i virtual server. 

   On the IBM i client virtual server that will be using the media repository: 

 Vary on the virtual optical device using option 1 from the wrkcfgsts *dev opt* display. 

6.6 Redundant VIOS partitons using FSM 
FSM adds support for redundant VIOS virtual servers on a POWER node. Each VIOS must have shared 
access to the same storage LUNs used for the client IBM i virtual server. 
Refer to the sections 5.3.2.2 and 4.4.1 in the IBM i Virtualization and Open Storage Read-me First at: 
http://www.ibm.com/systems/resources/systems_i_Virtualization_Open_Storage.pdf  

 
By default, only one of a pair of redundant VIOS servers handles ALL of the Ethernet traffic for the client 
virtual servers.  This is configured as ha_mode=auto attribute on the shared Ethernet adapter (SEA) 
command.  To better utilize the 10 Gb Ethernet adapters owned by each VIOS server, ha_mode=sharing 

http://www.ibm.com/systems/resources/systems_i_Virtualization_Open_Storage.pdf
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was implemented.  The virtual Ethernet traffic handling is negotiated between the VIOS servers as 
additional LANs are configured, but there is a catch. You have to enable IEEE 802.1Q VLAN tagging on 
each virtual Ethernet LAN for this to work.  A different port VLAN ID (PVID) is not enough.  You don’t 
have to specify an explicit VLAN tag, just enable the tagging support on each virtual Ethernet adapter. 

 

7 Backup and restore 

7.1 Overview of backup and restore for IBM i on a POWER node 
 
The save and restore process for IBM i on a POWER node is not similar to that on other Power servers.  
Clients can only use a Fibre Channel-attached tape library with LTO drives.  The tape drive from the Fibre 
Channel tape library is recognized in the IBM i LPAR and follows the same naming convention as in any 
other IBM i environment.  This allows an administrator to use native IBM i save and restore commands or 
Backup, Recovery and Media Services (BRMS) as part of the same backup and recovery strategy 
employed on other Power servers.   
 
The physical adapters connecting to the tape devices are owned by VIOS.  The Fibre Channel-attached 
tape library solution uses NPIV, so that a tape drive from the library is directly mapped to IBM i in the SAN, 
with VIOS managing the physical FC adapter in a passthrough method. 
 
The following sections describe the technical details, support statements and implementation steps for 
backup and restore.   
 

7.2 Save and restore with a Fibre Channel-attached tape library 

7.2.1 Technical overview 
 
NPIV attached Fibre Channel (FC) tape libraries are supported for save and restore option for IBM i on a 
POWER node.  This capability allows an administrator to perform backup and recovery operations using 
the same IBM i native or BRMS commands as on any other IBM i LPAR attached to a tape library.  
Advanced capabilities such as automatic media change and hardware encryption of tape media are 
supported.  Encrypted tape volumes can then be read and used for restore on a non-node Power server 
connected to a tape library.   
 
VIOS uses N_Port ID Virtualization (NPIV) to allow IBM i direct access to a tape library in the SAN 
through an NPIV-capable adapter owned by VIOS.  NPIV is a Fibre Channel technology that enables a 
single port on a FC adapter to be presented to the SAN as an N-number of independent ports with 
different World-wide Port Names (WWPNs).  NPIV-capable adapters on Power servers and nodes allow 
up to 256 virtual FC ports to be assigned to a single physical FC port.  On Power servers and nodes, 
VIOS always owns and manages the FC adapter.   
 
To leverage NPIV, an IBM i LPAR must have a Virtual Fibre Channel (virtual FC) client adapter created, 
which connects to a virtual FC server adapter in VIOS, similar to the VSCSI model.  However, the virtual 
FC client adapter does not allow IBM i to access LUNs or tape drives already assigned to VIOS in the 
SAN.  Instead, the virtual FC server adapter in VIOS is mapped to a FC port on the physical NPIV-
capable adapter.  This allows the client virtual FC adapter in IBM i direct access to the physical port on 
the FC adapter, with VIOS having a “pass-through” role, unlike with VSCSI.  The tape drive in the FC tape 
library for IBM i use is not mapped to the WWPNs of the physical ports on the NPIV adapter and it does 
not become available in VIOS first.  Instead, when the virtual FC client adapter in the IBM i LPAR is 
created, two virtual WWPNs are generated by the PowerVM Hypervisor.  The tape drive in the library is 
zoned directly to the first of the two WWPNs on the virtual FC client adapter in IBM i.  The second WWPN 
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is used to facilitate Live Partition Mobility, although only AIX and Linux LPARs can leverage it at the 
moment.  The PowerVM Hypervisor on a Power server or node has the default capability to create 32,000 
virtual WWPNs.  When virtual FC client adapters are deleted, WWPNs are not reused.  If all of the default 
32,000 WWPNs are used, the client must obtain an enablement code from IBM, which allows the creation 
of a new set of 32,000 WWPNs.   
 
Zoning a tape drive in a FC tape library directly to a WWPN on the virtual FC client adapter in IBM i has 
two important advantages: 
 

 It allows simpler SAN zoning and I/O virtualization configuration on the POWER node.  The tape 
drive in the library does not have to be made available to VIOS first and then assigned to IBM i; 
instead, it is mapped to IBM i in the SAN 

 From the perspective of both the SAN device (the tape drive in the library) and IBM i, an NPIV 
connection is identical to a direct FC connection, which is otherwise not possible on POWER 
nodes.  NPIV enables IBM i to recognize and use all characteristics of the FC device, instead of 
using it as a generic tape drive virtualized by VIOS 

 
Figure 4 presents an overview of accessing a FC tape library through NPIV for IBM i on a POWER node: 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 4: An overview of accessing a FC tape library through NPIV for IBM i on a POWER processor-
based node. 
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7.2.2 Support statements and requirements for FC tape libraries 
 
Refer to the following APAR for the IBM i PTFs required and for D-Mode limitations for NPIV virtualization 
of Fibre Channel libraries and a current list of supported devices at:  http://www-
912.ibm.com/n_dir/nas4apar.nsf/c79815e083182fec862564c00079d117/02327e067599839e8625765900
3c6d66?OpenDocument&Highlight=2,ii14526. 
Note: that the NPIV PTFs must be permanently applied on the partition before a SAVSYS is done in 
order to allow D Mode IPL from that tape. 
 
Note that while all supported FC adapters and most supported FC switch modules operate at 8Gbps, the 
rest of the SAN does not have to operate at that speed.  Additional FC switches outside of the chassis 
can operate at 4Gbps or 2Gbps.  While this difference in throughput will have an effect on performance, it 
will not prevent NPIV from working.  Similarly, only the first FC switch connected to the NPIV adapter 
must be NPIV-enabled.  For this solution, that first FC switch is one of the supported switch modules 
(explained in this section). 
 
IBM i hosted by VIOS supports NPIV attachment of DS8000/DS5100/53000 logical drives. These logical 
drives must be formatted as IBM i 520 byte sector drives.  As with other support statements, this paper 
reflects the current support and its online master version is updated as IBM’s support position changes.   

7.2.3 Creating the virtual FC configuration using FSM 
Before the tape library can be mapped to IBM i in the SAN, the virtual FC server and client adapters must 
be created in VIOS and IBM i and the IBM i LPAR must be associated with the physical FC adapter.  
Perform the following steps define the virtual FC adapter:  

 On the Manage Power Systems Resources page: 

 Expand Virtual Servers and right-click the IBM i client virtual server you are configuring. 

 Click System Configuration -> Manage Profile.  Note: Do not use the Manage Virtual Server 
option as this creates a dynamic set of WWPNs. Later when you update the profile you will 
generate yet another set of WWPNs and they will not match. 

 Select the profile to update and select Actions -> Edit. 

 Click the Virtual Adapters tab. 

 Click the Actions -> Create Virtual Adapter -> Fibre Channel Adapter. 

 Select the box for making this adapter a required adapter.  

 Select the correct VIOS server partition that is hosting this client partition. 

 Click OK. 
 This creates the virtual FC adapter and the virtual WWPNs that are now assigned to that client 

virtual server.  If you go back into the IBM i partition, you should see the virtual WWPNs that were 
generated.  You can use these for zoning the tape to the IBM i client partition. 

 Perform the steps in the “Making the tape library available to IBM i” section. 
 
Note: Use the change port login (chnportlogin) command from the FSM CLI to bring the virtual FC ports 
online for the SAN fabric to detect. This allows the SAN zoning to be done easier.  Refer to the HMC 
commands at: 

http://publib.boulder.ibm.com/infocenter/powersys/v3r1m5/index.jsp?topic=/ipha1/usingthehmcr

emotecommandline.htm 
 

7.2.4 Making the tape library available to IBM i 
 
After configuring the virutal FC configurations is complete, making a tape drive within the FC tape library 
available to IBM i requires the correct zoning in the FC switch module in the chassis and any other 

http://www-912.ibm.com/n_dir/nas4apar.nsf/c79815e083182fec862564c00079d117/02327e067599839e86257659003c6d66?OpenDocument&Highlight=2,ii14526
http://www-912.ibm.com/n_dir/nas4apar.nsf/c79815e083182fec862564c00079d117/02327e067599839e86257659003c6d66?OpenDocument&Highlight=2,ii14526
http://www-912.ibm.com/n_dir/nas4apar.nsf/c79815e083182fec862564c00079d117/02327e067599839e86257659003c6d66?OpenDocument&Highlight=2,ii14526
http://publib.boulder.ibm.com/infocenter/powersys/v3r1m5/index.jsp?topic=/ipha1/usingthehmcremotecommandline.htm
http://publib.boulder.ibm.com/infocenter/powersys/v3r1m5/index.jsp?topic=/ipha1/usingthehmcremotecommandline.htm
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switches to which the tape library might be connected.  This process is identical to connecting a FC tape 
library directly over the SAN fabric to IBM i on a Power server without NPIV.   
 
Use the first WWPN from the virtual FC WWPN pair and refer to the Redbooks Implementing Tape in 
i5/OS at: http://www.redbooks.ibm.com/abstracts/sg247440.html?Open to perform the correct zoning.   
 
There is a web interface on the tape media library where you need to enable control paths from each 
device that you want IBM i to be able to work with. Selecting Enable creates the control paths.   
 
IBM i cannot dynamically detect these control paths.  To detect the control paths, you need to re-IPL 
(reboot) the virtual I/O adapter (IOA).    
 
First determine which virtual IOA has been created for the virtual fibre channel adapters. To do this, enter 
a WRKHDWRSC *STG command and check for a 6B25 (virtual FC) adapter.  Note the IOP/IOA name. 
 
Next, use STRSST and start a service function (1) -> hardware service manager (7) -> Logical Hardware 
Resources (2) – System bus resources (1).  Enter a 255 in the System bus(es) to work with field and hit 
enter.  This is the virtual adapter bus.  Locate the virtual IOA from above and enter a 6 for I/O debug, then 
option 4 to IPL the IOA.  Use F3 to exit SST. 
 
Return to the WRKHDWRSC *STG and use an option 9 to see the tape devices under the virtual FC IOA.   
With auto configuration turned on, a new tape device(s) should show up under WRKCFGSTS *DEV TAP*. 

7.2.5 Performing an IBM i save 
 
In IBM i, the FC tape library is recognized with the correct type and model, such as 3584-032 for TS3500, 
and is assigned a standard TAPMLBxx device name.  For instance, each LTO4 tape drive within the 
library mapped to the IBM i LPAR is recognized as a 3580-004 device with a TAPxx name.   
The tape library connected through NPIV supports all standard and advanced library functions, as well as 
both native save restore and BRMS commands.  Use the standard backup procedure or refer to the IBM i 
Information Center’s Backup and recovery topic at: 
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahg/rzahgbackup.htm 

7.2.6 Performing an IBM i restore 
 
IBM i can read from any supported tape media depending upon the model tape device used in the FC 
tape library and can perform both full-system and partial restores.  You can use the  standard restore 
procedure or refer to the IBM i Information Center’s Backup and recovery topic at: 
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahg/rzahgbackup.htm. 
 

7.2.7 Performing a D-mode IPL from a FC tape library using FSM 
 
It is possible to perform a full-system save in an IBM i partition on a different system and then use that 
save for a D-mode IPL and full-system restore on a node with access to a FC tape library.  To perform a 
D-mode IPL from a tape library, use the following steps: 
Note: Make sure that you have the requisite PTFs permanently applied on the system prior to the save 
system.  

 Verify that the tape drive is powered on and the tape is loaded 

 Verify that the correct tape drive in the library is zoned to one of the WWPNs on the virtual FC 
client adapter in the IBM i LPAR 

 Verify that the correct virtual FC client adapter is selected as an alternate IPL resource for the 
IBM i partition: 

 On the Manage Power Systems Resources page: 

http://www.redbooks.ibm.com/abstracts/sg247440.html?Open
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahg/rzahgbackup.htm
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahg/rzahgbackup.htm
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 Expand Virtual Servers and right-click the IBM i client virtual server you are configuring. 

 Click System Configuration -> Manage Profile.   

 On the General partition properties tab, verify that the virtual FC client adapter with the correct 
WWPNs is selected from the Alternate restart adapter list. 

 On the same tab, verify that the IBM i partition is configured for a D-mode manual IPL. 

 Close the partition properties window. 

 Select the IBM i partition and click Operations -> Activate -> Profile. 

7.3 Backup and restore of VIOS  
 
For a “bare metal” type of restore of the entire POWER node, backups of VIOS and the LPAR 
configuration are also required.  Saving VIOS, the LPAR configuration and IBM i on the node can be 
performed in any order.  During a restore, VIOS and the LPAR configuration are restored first, followed by 
IBM i as described earlier in this section.  VIOS can be backed up to DVDs or to a Network Install 
Manager (NIM server).  For more information on NIM servers and backing up to them, see the Redbook: 

NIM from A to Z in AIX 5L at http://www.redbooks.ibm.com/abstracts/sg247296.html 

7.3.1 Backing up VIOS to DVDs 
 

The VIOS can be backed up to DVDs using the following steps.  
The client (hosted) partitions are do not have to be inactive. 
Ensure a blank tape is loaded in the tape device you is using for the backup. 

 Telnet or PuTTY into VIOS. Log in using the padmin user ID. 

 Backup the partition profile data by typing the following command: 
o bkprofdata –o backup –f profile.bak.  
This results in a profile backup file location of /home/padmin/profile.bak.   

Alternatively, the partition profile can be backed up through FSM using the following steps: 

 Log into the FSM. 

 On the Manage Power Systems Resources page, click on POWER node you want to work with.  

 Right click and select System Configuration -> Manage Virtual Server Data -> Backup. 

 Provide a backup file name and click OK. 

 As soon as the operation is complete, a confirmation window is shone. 

 Find the DVD device name by typing the following command from the VIOS CLI: lsdev –type 
optical 
If the device has a status of Defined, type the following command, with name as the DVD device 
name: cfgdev –dev name   

 Check the current physical block size  for the DVD device using the following command, with 
name as the tape device name: lsdev –dev name –attr  

 Change the block size to 262144 if it is smaller than that using the command: 
o chdev –dev name –attr block_size=262144  

 Perform the VIOS backup, saving 512 blocks at a time, by using the following command: 
o backupios  -tape /dev/rmt0 -blocks 512 

 
The resulting tape is a bootable VIOS backup. 
 
Alternatively, the partition profile can be backed up through the FSM interface using the following steps:  

 On the FSM welcome page, expand Hosts. Select the node server and then click System 
Configuration -> Manage Virtual Server Data -> Backup. 

 Enter a file name for the backup when prompted. 

 Click Ok. 

7.3.2 Restoring VIOS from a DVD backup 
 

http://www.redbooks.ibm.com/abstracts/sg247296.html
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The steps to restore the VIOS from a DVD backup are described in this section. Ensure that the backup 
DVD media is loaded in the DVD device before proceeding. 
 
Perform the following steps to restore VIOS. 

 Log into the FSM. 

 On the Manage Power Systems Resources page, click on POWER node you want to work 
with.  

 Open a console for VIOS on the FSM using the steps in section “Opening a VIOS console 
using FSM”. 

 Power on or restart the POWER node: Right click on the node and select Operations -> 
Power On.  

 On the console, when the Partition Firmware displays its initial screen (a series of IBM’s scroll 
across the console), press 1 to enter the SMS menu. If you miss the prompt to press 1, the 
partition will attempt to boot from the default device, which might boot back into VIOS, if there 
is still a bootable image installed on the default device (probably the internal hard drive).  
Otherwise, the boot will fail and the SMS menu will eventually be displayed. 
 

 
 

 On the SMS Main Menu, type 5 to select the Select Boot Options and press Enter. 
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 On the Multiboot menu, type 1 to select the Select Install/Boot Device and press Enter. 

 
 

 On the Select Device Type menu, type 3 to select CD/DVD and press Enter. 
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 On the Select Media Type menu, type 6 to select USB and press Enter. 
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 On the Select Device menu, type the device number for the tape device with the backup 
media loaded and press Enter. 

 
 

 On the Select Task menu, type 2 for Normal Boot Mode and press Enter. 

 
 

 Type 1 and press Enter to confirm that you want to exit the SMS menus. It will take several 
minutes to boot from the tape. 
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 As soon as you are past the Welcome to the Virtual I/O Server screen, a screen with the 
Please define the System Console message is displayed . Type 2 and press Enter as the 
screen directs.  Note that these keystrokes will not appear on the screen. 

 
 

 You may see a warning screen indicating the disks on the system do not match the disks on 
the source (of the backup) system. Type 1 and press Enter to continue with the installation. 
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 On the Welcome to Base Operating System – Installation and Maintenance menu, type 3 
to select the Start Maintenance Mode for System Recovery option and press Enter. 
 

 
 

 On the Maintenance menu, type 6 to select the Install from a System Backup and press 
Enter. 
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 On the Choose mksysb Device menu, type the number of the device with the backup tape 
mounted and press Enter. The restore will now begin.  A progress screen is displayed until 
the restore is complete. 
 

 
As soon as the restore is complete, the VIOS will reboot from the just completed restore image. 
 
After restoring VIOS, restore the partition data. The partition data can be restored by using the following 
command on the VIOS console (assuming you used the bkprofdata command as described earlier): 
rstprofdata –l 1 –f profile.bak --ignoremtms. 
 
Alternatively, the partition (virtual server) data can be restored through the FSM (if saved through the 
FSM) using the following steps: 
 

 Log into the FSM. 

 On the Manage Power Systems Resources page, click on POWER node you want to work 
with.  

 Right click and select System Configuration -> Manage Virtual Server Data -> Restore. 

 Select the backup file you want to restore. 

 Select the backup you want to perform from the following types: 
o Full Restore – Restore from the backup file and don’t merge with the existing FSM 

virtual server data. 
o Backup Priority – Merge the backup data with the current FSM virtual server data 

but prioritize the backup file contents if there are conflicts between it and current FSM 
data. 

o Host Priority – Merge the backup data with the current FSM virtual server data but 
prioritize the FSM contents if there are conflicts between the current FSM data and 
the backup data. 

o Click OK. 
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8 Additional resources 

8.1 PureFlex System documentation 
 
We now have a new portal on our web site for the Product Guides, book, and papers: 
http://www.redbooks.ibm.com/portals/puresystems 
 
Redbooks and Redpapers - online in draft format 
 

 IBM PureFlex System Products & Technology,  
http://www.redbooks.ibm.com/abstracts/sg247984.html?Open 

 IBM Flex System p260 and p460 Planning and Implementation Guide,  
http://www.redbooks.ibm.com/abstracts/sg247989.html?Open 

 IBM Flex System Networking in an Enterprise Data Center,  
http://www.redbooks.ibm.com/abstracts/redp4834.html?Open 

 
xREF: 
 

 xREF: IBM BladeCenter and System x Reference, http://www.redbooks.ibm.com/xref 
 
Product Guides: 
 
All available individually or from our Product Guide landing page: 
http://www.redbooks.ibm.com/portals/puresystems?Open&page=pgbycat 
 
Chassis and compute nodes 
 

 IBM Flex System Enterprise Chassis 

 IBM Flex System Manager 

 IBM Flex System p260 and p460 Compute Node 
 

Product Guides - Switches and pass-thru modules 
 

 IBM Flex System EN2092 1Gb Ethernet Scalable Switch 

 IBM Flex System EN4091 10Gb Ethernet Pass-thru Module 

 IBM Flex System Fabric EN4093 10Gb Scalable Switch 

 IBM Flex System FC3171 8Gb SAN Switch and Passthru 

 IBM Flex System FC5022 16Gb SAN Scalable Switch and FC5022 24-port 16Gb ESB SAN Scalable 
Switch 

 
Product Guides - Adapter cards 
 

 IBM Flex System CN4054 10Gb Virtual Fabric Adapter and EN4054 4-port 10Gb Ethernet Adapter 

 IBM Flex System EN2024 4-port 1Gb Ethernet Adapter 

 IBM Flex System EN4132 2-port 10Gb Ethernet Adapter 

 IBM Flex System FC3052 2-port 8Gb FC Adapter 

 IBM Flex System FC3172 2-port 8Gb FC Adapter 

 IBM Flex System FC5022 2-port 16Gb FC Adapter 

 ServeRAID M5115 SAS/SATA Controller for IBM Flex System 

 

http://www.redbooks.ibm.com/portals/puresystems
http://www.redbooks.ibm.com/abstracts/sg247984.html?Open
http://www.redbooks.ibm.com/abstracts/sg247989.html?Open
http://www.redbooks.ibm.com/abstracts/redp4834.html?Open
http://www.redbooks.ibm.com/xref
http://www.redbooks.ibm.com/portals/puresystems?Open&page=pgbycat
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8.2 Storage 
 

 Implementing the IBM Storwize V7000 in IBM Redbooks available at: 
http://www.redbooks.ibm.com/abstracts/sg247938.html?Open 

 Performance Capabilities Reference manual (chapter 6 for best practices for IBM i and VIOS 
or chapter 18 for POWER blades): 
http://www.ibm.com/systems/i/solutions/perfmgmt/resource.html 

 SDDPCM driver: http://www.ibm.com/support/docview.wss?uid=ssg1S4000201  
 

8.3 VIOS 
 

 PowerVM Editions Operations Guide: 
http://publib.boulder.ibm.com/infocenter/systems/index.jsp?topic=/iphdx/abstract_pvme_guid
e.htm. 

 IBM Power Virtualization: Introduction and Configuration (Redbook):  
http://www.redbooks.ibm.com/abstracts/sg247940.html 

 VIOS command reference:  
http://publib.boulder.ibm.com/infocenter/systems/scope/hw/index.jsp?topic=/iphb1/iphb1_vios
_commandslist.htm  

 VIOS Datasheet:  
http://www14.software.ibm.com/webapp/set2/sas/f/vios/documentation/datasheet.html  

 

8.4 IBM i 
 

 IBM i installation: 
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahc/installprocess.
htm  

 IBM i PTF installation: 
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahc/installptfsforlic
andos.htm  

 Latest recommended IBM i PTFs: http://www-
912.ibm.com/s_dir/slkbase.nsf/recommendedfixesIBM Fix Central: http://www-
912.ibm.com/eserver/support/fixes/ 

 IBM Systems Workload Estimator: http://www-
304.ibm.com/systems/support/tools/estimator/index.html 

 IBM i networking: 
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahg/rzahgicnet2.ht
m  

 ECS over LAN: 
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzaji/rzajiecs.htm  

 IBM i virtual client partitions topics in the IBM i Information Center: 
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahc/rzahcblade5os
virtualpartitionsoverview.htm  

 Backup and recovery Information Center topic: 
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahg/rzahgbackup.h
tm  

 Implementing Tape in i5/OS (Redbook):  
http://www.redbooks.ibm.com/abstracts/sg247440.html?Open. 

http://www.redbooks.ibm.com/abstracts/sg247938.html?Open
http://www-03.ibm.com/systems/i/solutions/perfmgmt/resource.html
http://www.ibm.com/support/docview.wss?uid=ssg1S4000201
http://publib.boulder.ibm.com/infocenter/systems/index.jsp?topic=/iphdx/abstract_pvme_guide.htm
http://publib.boulder.ibm.com/infocenter/systems/index.jsp?topic=/iphdx/abstract_pvme_guide.htm
http://www.redbooks.ibm.com/abstracts/sg247940.html
http://publib.boulder.ibm.com/infocenter/systems/scope/hw/index.jsp?topic=/iphb1/iphb1_vios_commandslist.htm
http://publib.boulder.ibm.com/infocenter/systems/scope/hw/index.jsp?topic=/iphb1/iphb1_vios_commandslist.htm
http://www14.software.ibm.com/webapp/set2/sas/f/vios/documentation/datasheet.html
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahc/installprocess.htm
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahc/installprocess.htm
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahc/installptfsforlicandos.htm
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahc/installptfsforlicandos.htm
http://www-912.ibm.com/s_dir/slkbase.nsf/recommendedfixes
http://www-912.ibm.com/s_dir/slkbase.nsf/recommendedfixes
http://www-912.ibm.com/eserver/support/fixes/
http://www-912.ibm.com/eserver/support/fixes/
http://www-304.ibm.com/systems/support/tools/estimator/index.html
http://www-304.ibm.com/systems/support/tools/estimator/index.html
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahg/rzahgicnet2.htm
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahg/rzahgicnet2.htm
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzaji/rzajiecs.htm
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahc/rzahcblade5osvirtualpartitionsoverview.htm
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahc/rzahcblade5osvirtualpartitionsoverview.htm
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahg/rzahgbackup.htm
http://publib.boulder.ibm.com/infocenter/iseries/v7r1m0/index.jsp?topic=/rzahg/rzahgbackup.htm
http://www.redbooks.ibm.com/abstracts/sg247440.html?Open
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 APAR for PTFs required for NPIV virtualization of Fibre Channel tape libraries: http://www-
912.ibm.com/n_dir/nas4apar.nsf/c79815e083182fec862564c00079d117/02327e067599839e
86257659003c6d66?OpenDocument&Highlight=2,ii14526.  

 
 

 

9 Trademarks and disclaimers 
 
© Copyright IBM Corporation 2012. All rights Reserved. 
References in this document to IBM products or services do not imply that IBM intends to make them 
available in every country. 
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business 
Machines Corporation in the United States, other countries, or both. If these and other IBM trademarked 
terms are marked on their first occurrence in this information with a trademark symbol (® or ™), these 
symbols indicate U.S. registered or common law trademarks owned by IBM at the time this information 
was published. Such trademarks may also be registered or common law trademarks in other countries. A 
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Other company, product, or service names may be trademarks or service marks of others.  
Information is provided "AS IS" without warranty of any kind. 
All customer examples described are presented as illustrations of how those customers have used IBM 
products and the results they may have achieved. Actual environmental costs and performance 
characteristics may vary by customer. 
Information concerning non-IBM products was obtained from a supplier of these products, published 
announcement material, or other publicly available sources and does not constitute an endorsement of 
such products by IBM. Sources for non-IBM list prices and performance numbers are taken from publicly 
available information, including vendor announcements and vendor worldwide homepages. IBM has not 
tested these products and cannot confirm the accuracy of performance, capability, or any other claims 
related to non-IBM products. Questions on the capability of non-IBM products should be addressed to the 
supplier of those products. 
All statements regarding IBM future direction and intent are subject to change or withdrawal without 
notice, and represent goals and objectives only. Contact your local IBM office or IBM authorized reseller 
for the full text of the specific Statement of Direction. 
Some information addresses anticipated future capabilities. Such information is not intended as a 
definitive statement of a commitment to specific levels of performance, function or delivery schedules with 
respect to any future products. Such commitments are only made in IBM product announcements. The 
information is presented here to communicate IBM's current investment and development activities as a 
good faith effort to help with our customers' future planning.  
Performance is based on measurements and projections using standard IBM benchmarks in a controlled 
environment. The actual throughput or performance that any user will experience will vary depending 
upon considerations such as the amount of multiprogrCMMing in the user's job stream, the I/O 

http://www-912.ibm.com/n_dir/nas4apar.nsf/c79815e083182fec862564c00079d117/02327e067599839e86257659003c6d66?OpenDocument&Highlight=2,ii14526
http://www-912.ibm.com/n_dir/nas4apar.nsf/c79815e083182fec862564c00079d117/02327e067599839e86257659003c6d66?OpenDocument&Highlight=2,ii14526
http://www-912.ibm.com/n_dir/nas4apar.nsf/c79815e083182fec862564c00079d117/02327e067599839e86257659003c6d66?OpenDocument&Highlight=2,ii14526
http://www.ibm.com/legal/copytrade.shtml
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configuration, the storage configuration, and the workload processed. Therefore, no assurance can be 
given that an individual user will achieve throughput or performance improvements equivalent to the 
ratios stated here. 
Photographs shown are of engineering prototypes. Changes may be incorporated in production models. 
Any references in this information to non-IBM websites are provided for convenience only and do not in 
any manner serve as an endorsement of those websites. The materials at those websites are not part of 
the materials for this IBM product and use of those websites is at your own risk. 

 

 

            

    

    

        

    

    

                

    

    

        

    

            

                    


